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Visual Basic Language Walkthroughs

 

Walkthroughs give step-by-step instructions for common scenarios, which makes them a good place to start learning about

the product or a particular feature area.

Writing an Async Program

Shows how to create an asynchronous solution by using Async and Await, which are introduced in Visual Studio 2012.

Declaring and Raising Events

Illustrates how events are declared and raised in Visual Basic.

Handling Events

Shows how to handle events using either the standard WithEvents keyword or the new

AddHandler/RemoveHandler keywords.

Creating and Implementing Interfaces

Shows how interfaces are declared and implemented in Visual Basic.

Defining Classes

Describes how to declare a class and its fields, properties, methods, and events.

Writing Queries in Visual Basic

Demonstrates how you can use Visual Basic language features to write Language-Integrated Query (LINQ) query

expressions.

Implementing IEnumerable(Of T) in Visual Basic

Demonstrates how to create a class that implements the IEnumerable(Of String) interface and a class that

implements the IEnumerator(Of String) interface to read a text file one line at a time.

Calling Windows APIs

Explains how to use Declare statements and call Windows APIs. Includes information about using attributes to

control marshaling for the API call and how to expose an API call as a method of a class.

Creating COM Objects with Visual Basic

Demonstrates how to create COM objects in Visual Basic, both with and without the COM class template.

Implementing Inheritance with COM Objects

Demonstrates how to use Visual Basic 6.0 to create a COM object containing a class, and then use it as a base class in

Visual Basic.

Multithreading

Shows how to create a multithreaded application that searches a text file for occurrences of a word.

Determining Where My.Application.Log Writes Information

Describes the default My.Application.Log settings and how to determine the settings for your application.

Changing Where My.Application.Log Writes Information

Shows how to override the default My.Application.Log and My.Log settings for logging event information and
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cause the Log object to write to other log listeners.

Filtering My.Application.Log Output

Demonstrates how to change the default log filtering for the My.Application.Log object.

Creating Custom Log Listeners

Demonstrates how to create a custom log listener and configure it to listen to the output of the My.Application.Log

object.

Embedding Types from Managed Assemblies

Describes how to create an assembly and a client program that embeds types from it.

Validating That Passwords Are Complex (Visual Basic)

Demonstrates how to check for strong-password characteristics and update a string parameter with information

about which checks a password fails.

Encrypting and Decrypting Strings in Visual Basic

Shows how to use the DESCryptoServiceProvider class to encrypt and decrypt strings.

Manipulating Files and Folders in Visual Basic

Demonstrates how to use Visual Basic functions to determine information about a file, search for a string in a file, and

write to a file.

Manipulating Files Using .NET Framework Methods

Demonstrates how to use .NET Framework methods to determine information about a file, search for a string in a file,

and write to a file.

Persisting an Object in Visual Basic

Demonstrates how to create a simple object and persist its data to a file.

Test-First Support with the Generate from Usage Feature

Demonstrates how to do test-first development, in which you first write unit tests and then write the source code to

make the tests succeed.

© 2016 Microsoft

Visual Basic Language Walkthroughs https://msdn.microsoft.com/en-us/library/9a4y3z34(d=printer).aspx

2 of 2 01.09.2016 23:13



Walkthrough: Declaring and Raising Events
(Visual Basic)

 

This walkthrough demonstrates how to declare and raise events for a class named Widget. After you complete the steps, you

might want to read the companion topic, Walkthrough: Handling Events (Visual Basic), which shows how to use events from

Widget objects to provide status information in an application.

The Widget Class
Assume for the moment that you have a Widget class. Your Widget class has a method that can take a long time to

execute, and you want your application to be able to put up some kind of completion indicator.

Of course, you could make the Widget object show a percent-complete dialog box, but then you would be stuck with

that dialog box in every project in which you used the Widget class. A good principle of object design is to let the

application that uses an object handle the user interface—unless the whole purpose of the object is to manage a form or

dialog box.

The purpose of Widget is to perform other tasks, so it is better to add a PercentDone event and let the procedure that

calls Widget's methods handle that event and display status updates. The PercentDone event can also provide a

mechanism for canceling the task.

To build the code example for this topic

Open a new Visual Basic Windows Application project and create a form named Form1.1. 

Add two buttons and a label to Form1.2. 

Name the objects as shown in the following table.

Object Property Setting

Button1 Text Start Task

Button2 Text Cancel

Label (Name), Text lblPercentDone, 0

3. 

On the Project menu, choose Add Class to add a class named Widget.vb to the project.4. 

To declare an event for the Widget class

Visual Studio 2015
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Use the Event keyword to declare an event in the Widget class. Note that an event can have ByVal and ByRef

arguments, as Widget's PercentDone event demonstrates:

When the calling object receives a PercentDone event, the Percent argument contains the percentage of the task that is

complete. The Cancel argument can be set to True to cancel the method that raised the event.

Note

You can declare event arguments just as you do arguments of procedures, with the following exceptions: Events

cannot have Optional or ParamArray arguments, and events do not have return values.

The PercentDone event is raised by the LongTask method of the Widget class. LongTask takes two arguments: the

length of time the method pretends to be doing work, and the minimum time interval before LongTask pauses to raise

the PercentDone event.

To raise the PercentDone event

To simplify access to the Timer property used by this class, add an Imports statement to the top of the

declarations section of your class module, above the Class Widget statement.

1. 

Add the following code to the Widget class:2. 

Public Event PercentDone(ByVal Percent As Single, 

ByRef Cancel As Boolean)

Imports Microsoft.VisualBasic.DateAndTime

Public Sub LongTask(ByVal Duration As Single, 

ByVal MinimumInterval As Single)

Dim Threshold As Single

Dim Start As Single

Dim blnCancel As Boolean

' The Timer property of the DateAndTime object returns the seconds

' and milliseconds that have passed since midnight.

    Start = CSng(Timer)

    Threshold = MinimumInterval

Do While CSng(Timer) < (Start + Duration)

' In a real application, some unit of work would

' be done here each time through the loop.

If CSng(Timer) > (Start + Threshold) Then

VB
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When your application calls the LongTask method, the Widget class raises the PercentDone event every

MinimumInterval seconds. When the event returns, LongTask checks to see if the Cancel argument was set to True.

A few disclaimers are necessary here. For simplicity, the LongTask procedure assumes you know in advance how long the

task will take. This is almost never the case. Dividing tasks into chunks of even size can be difficult, and often what matters

most to users is simply the amount of time that passes before they get an indication that something is happening.

You may have spotted another flaw in this sample. The Timer property returns the number of seconds that have passed

since midnight; therefore, the application gets stuck if it is started just before midnight. A more careful approach to

measuring time would take boundary conditions such as this into consideration, or avoid them altogether, using

properties such as Now.

Now that the Widget class can raise events, you can move to the next walkthrough. Walkthrough: Handling Events (Visual

Basic) demonstrates how to use WithEvents to associate an event handler with the PercentDone event.

See Also
Timer

Now

Walkthrough: Handling Events (Visual Basic)

Events (Visual Basic)

© 2016 Microsoft

RaiseEvent PercentDone( 

            Threshold / Duration, blnCancel)

' Check to see if the operation was canceled.

If blnCancel Then Exit Sub

            Threshold = Threshold + MinimumInterval

End If

Loop

End Sub
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Walkthrough: Handling Events (Visual Basic)

 

This is the second of two topics that demonstrate how to work with events. The first topic, Walkthrough: Declaring and

Raising Events, shows how to declare and raise events. This section uses the form and class from that walkthrough to show

how to handle events when they take place.

The Widget class example uses traditional event-handling statements. Visual Basic provides other techniques for working

with events. As an exercise, you can modify this example to use the AddHandler and Handles statements.

To handle the PercentDone event of the Widget class

Place the following code in Form1:

The WithEvents keyword specifies that the variable mWidget is used to handle an object's events. You specify the

kind of object by supplying the name of the class from which the object will be created.

The variable mWidget is declared in Form1 because WithEvents variables must be class-level. This is true regardless

of the type of class you place them in.

The variable mblnCancel is used to cancel the LongTask method.

1. 

Writing Code to Handle an Event
As soon as you declare a variable using WithEvents, the variable name appears in the left drop-down list of the class's

Code Editor. When you select mWidget, the Widget class's events appear in the right drop-down list. Selecting an event

displays the corresponding event procedure, with the prefix mWidget and an underscore. All the event procedures

associated with a WithEvents variable are given the variable name as a prefix.

To handle an event

Select mWidget from the left drop-down list in the Code Editor.1. 

Select the PercentDone event from the right drop-down list. The Code Editor opens the mWidget_PercentDone

event procedure.

Note

2. 

Visual Studio 2015

Private WithEvents mWidget As Widget

Private mblnCancel As Boolean
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The Code Editor is useful, but not required, for inserting new event handlers. In this walkthrough, it is more

direct to just copy the event handlers directly into your code.

Add the following code to the mWidget_PercentDone event handler:

Whenever the PercentDone event is raised, the event procedure displays the percent complete in a Label control.

The DoEvents method allows the label to repaint, and also gives the user the opportunity to click the Cancel

button.

3. 

Add the following code for the Button2_Click event handler:4. 

If the user clicks the Cancel button while LongTask is running, the Button2_Click event is executed as soon as the

DoEvents statement allows event processing to occur. The class-level variable mblnCancel is set to True, and the

mWidget_PercentDone event then tests it and sets the ByRef Cancel argument to True.

Connecting a WithEvents Variable to an Object
Form1 is now set up to handle a Widget object's events. All that remains is to find a Widget somewhere.

When you declare a variable WithEvents at design time, no object is associated with it. A WithEvents variable is just like

any other object variable. You have to create an object and assign a reference to it with the WithEvents variable.

To create an object and assign a reference to it

Select (Form1 Events) from the left drop-down list in the Code Editor.1. 

Select the Load event from the right drop-down list. The Code Editor opens the Form1_Load event procedure.2. 

Private Sub mWidget_PercentDone( 

ByVal Percent As Single, 

ByRef Cancel As Boolean 

) Handles mWidget.PercentDone

    lblPercentDone.Text = CInt(100 * Percent) & "%"

My.Application.DoEvents()

If mblnCancel Then Cancel = True

End Sub

Private Sub Button2_Click( 

ByVal sender As Object, 

ByVal e As System.EventArgs 

) Handles Button2.Click

    mblnCancel = True

End Sub
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Add the following code for the Form1_Load event procedure to create the Widget:3. 

When this code executes, Visual Basic creates a Widget object and connects its events to the event procedures associated

with mWidget. From that point on, whenever the Widget raises its PercentDone event, the mWidget_PercentDone event

procedure is executed.

To call the LongTask method

Add the following code to the Button1_Click event handler:

Before the LongTask method is called, the label that displays the percent complete must be initialized, and the class-level

Boolean flag for canceling the method must be set to False.

LongTask is called with a task duration of 12.2 seconds. The PercentDone event is raised once every one-third of a

second. Each time the event is raised, the mWidget_PercentDone event procedure is executed.

When LongTask is done, mblnCancel is tested to see if LongTask ended normally, or if it stopped because mblnCancel

was set to True. The percent complete is updated only in the former case.

To run the program

Press F5 to put the project in run mode.1. 

Click the Start Task button. Each time the PercentDone event is raised, the label is updated with the percentage

of the task that is complete.

2. 

Click the Cancel button to stop the task. Notice that the appearance of the Cancel button does not change

immediately when you click it. The Click event cannot happen until the My.Application.DoEvents statement

3. 

Private Sub Form1_Load( 

ByVal sender As System.Object, 

ByVal e As System.EventArgs 

) Handles MyBase.Load

    mWidget = New Widget

End Sub

Private Sub Button1_Click( 

ByVal sender As Object, 

ByVal e As System.EventArgs 

) Handles Button1.Click

    mblnCancel = False

    lblPercentDone.Text = "0%"

    lblPercentDone.Refresh()

    mWidget.LongTask(12.2, 0.33)

If Not mblnCancel Then lblPercentDone.Text = CStr(100) & "%"

End Sub
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allows event processing.

Note

The My.Application.DoEvents method does not process events in exactly the same way as the form does. For

example, in this walkthrough, you must click the Cancel button twice. To allow the form to handle the events

directly, you can use multithreading. For more information, see Threading (C# and Visual Basic).

You may find it instructive to run the program with F11 and step through the code a line at a time. You can clearly see

how execution enters LongTask, and then briefly re-enters Form1 each time the PercentDone event is raised.

What would happen if, while execution was back in the code of Form1, the LongTask method were called again? At worst,

a stack overflow might occur if LongTask were called every time the event was raised.

You can cause the variable mWidget to handle events for a different Widget object by assigning a reference to the new

Widget to mWidget. In fact, you can make the code in Button1_Click do this every time you click the button.

To handle events for a different widget

Add the following line of code to the Button1_Click procedure, immediately preceding the line that reads

mWidget.LongTask(12.2, 0.33):

The code above creates a new Widget each time the button is clicked. As soon as the LongTask method completes, the

reference to the Widget is released, and the Widget is destroyed.

A WithEvents variable can contain only one object reference at a time, so if you assign a different Widget object to

mWidget, the previous Widget object's events will no longer be handled. If mWidget is the only object variable containing

a reference to the old Widget, the object is destroyed. If you want to handle events from several Widget objects, use the

AddHandler statement to process events from each object separately.

Note

You can declare as many WithEvents variables as you need, but arrays of WithEvents variables are not supported.

See Also

mWidget = New Widget

' Create a new Widget object.
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Walkthrough: Declaring and Raising Events (Visual Basic)

Events (Visual Basic)
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How to: Declare Custom Events To Avoid
Blocking (Visual Basic)

 

There are several circumstances when it is important that one event handler not block subsequent event handlers. Custom

events allow the event to call its event handlers asynchronously.

By default, the backing-store field for an event declaration is a multicast delegate that serially combines all the event

handlers. This means that if one handler takes a long time to complete, it blocks the other handlers until it completes. (Well-

behaved event handlers should never perform lengthy or potentially blocking operations.)

Instead of using the default implementation of events that Visual Basic provides, you can use a custom event to execute the

event handlers asynchronously.

Example
In this example, the AddHandler accessor adds the delegate for each handler of the Click event to an ArrayList stored in

the EventHandlerList field.

When code raises the Click event, the RaiseEvent accessor invokes all the event handler delegates asynchronously using

the BeginInvoke method. That method invokes each handler on a worker thread and returns immediately, so handlers

cannot block one another.

Visual Studio 2015
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See Also
ArrayList

BeginInvoke

Events (Visual Basic)

How to: Declare Custom Events To Conserve Memory (Visual Basic)

© 2016 Microsoft

Public NotInheritable Class ReliabilityOptimizedControl

'Defines a list for storing the delegates

Private EventHandlerList As New ArrayList

'Defines the Click event using the custom event syntax.

'The RaiseEvent always invokes the delegates asynchronously

Public Custom Event Click As EventHandler

AddHandler(ByVal value As EventHandler)

            EventHandlerList.Add(value)

End AddHandler

RemoveHandler(ByVal value As EventHandler)

            EventHandlerList.Remove(value)

End RemoveHandler

RaiseEvent(ByVal sender As Object, ByVal e As EventArgs)

For Each handler As EventHandler In EventHandlerList

If handler IsNot Nothing Then

                    handler.BeginInvoke(sender, e, Nothing, Nothing)

End If

Next

End RaiseEvent

End Event

End Class
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How to: Declare Custom Events To Conserve
Memory (Visual Basic)

 

There are several circumstances when it is important that an application keep its memory usage low. Custom events allow

the application to use memory only for the events that it handles.

By default, when a class declares an event, the compiler allocates memory for a field to store the event information. If a class

has many unused events, they needlessly take up memory.

Instead of using the default implementation of events that Visual Basic provides, you can use custom events to manage the

memory usage more carefully.

Example
In this example, the class uses one instance of the EventHandlerList class, stored in the Events field, to store information

about the events in use. The EventHandlerList class is an optimized list class designed to hold delegates.

All events in the class use the Events field to keep track of what methods are handling each event.

Visual Studio 2015

Public Class MemoryOptimizedBaseControl

' Define a delegate store for all event handlers.

Private Events As New System.ComponentModel.EventHandlerList

' Define the Click event to use the delegate store.

Public Custom Event Click As EventHandler

AddHandler(ByVal value As EventHandler)

            Events.AddHandler("ClickEvent", value)

End AddHandler

RemoveHandler(ByVal value As EventHandler)

            Events.RemoveHandler("ClickEvent", value)

End RemoveHandler

RaiseEvent(ByVal sender As Object, ByVal e As EventArgs)

CType(Events("ClickEvent"), EventHandler).Invoke(sender, e)

End RaiseEvent

End Event

' Define the DoubleClick event to use the same delegate store.

Public Custom Event DoubleClick As EventHandler

AddHandler(ByVal value As EventHandler)

            Events.AddHandler("DoubleClickEvent", value)

End AddHandler

RemoveHandler(ByVal value As EventHandler)

            Events.RemoveHandler("DoubleClickEvent", value)

End RemoveHandler
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See Also
EventHandlerList

Events (Visual Basic)

How to: Declare Custom Events To Avoid Blocking (Visual Basic)
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RaiseEvent(ByVal sender As Object, ByVal e As EventArgs)

CType(Events("DoubleClickEvent"), EventHandler).Invoke(sender, e)

End RaiseEvent

End Event

' Define additional events to use the same delegate store.

' ...

End Class
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Troubleshooting Inherited Event Handlers in
Visual Basic

 

This topic lists common issues that arise with event handlers in inherited components.

Procedures

Code in Event Handler Executes Twice for Every Call

An inherited event handler must not include a Handles Clause (Visual Basic) clause. The method in the base class is

already associated with the event and will fire accordingly. Remove the Handles clause from the inherited method.

If the inherited method does not have a Handles keyword, verify that your code does not contain an extra

AddHandler Statement or any additional methods that handle the same event.

See Also
Events (Visual Basic)

© 2016 Microsoft
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' INCORRECT

Protected Overrides Sub Button1_Click( 

ByVal sender As System.Object, 

ByVal e As System.EventArgs) Handles Button1.Click

' The Handles clause will cause all code

' in this block to be executed twice.

End Sub
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Walkthrough: Creating and Implementing
Interfaces (Visual Basic)

 

Interfaces describe the characteristics of properties, methods, and events, but leave the implementation details up to

structures or classes.

This walkthrough demonstrates how to declare and implement an interface.

Note

This walkthrough doesn't provide information about how to create a user interface.

Note

Your computer might show different names or locations for some of the Visual Studio user interface elements in the

following instructions. The Visual Studio edition that you have and the settings that you use determine these elements.

For more information, see Personalizing the Visual Studio IDE.

To define an interface

Open a new Visual Basic Windows Application project.1. 

Add a new module to the project by clicking Add Module on the Project menu.2. 

Name the new module Module1.vb and click Add. The code for the new module is displayed.3. 

Define an interface named TestInterface within Module1 by typing Interface TestInterface between the

Module and End Module statements, and then pressing ENTER. The Code Editor indents the Interface keyword and

adds an End Interface statement to form a code block.

4. 

Define a property, method, and event for the interface by placing the following code between the Interface and End

Interface statements:

5. 

Visual Studio 2015

Property Prop1() As Integer

Sub Method1(ByVal X As Integer)

Event Event1()

VB
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Implementation
You may notice that the syntax used to declare interface members is different from the syntax used to declare class

members. This difference reflects the fact that interfaces cannot contain implementation code.

To implement the interface

Add a class named ImplementationClass by adding the following statement to Module1, after the End

Interface statement but before the End Module statement, and then pressing ENTER:

If you are working within the integrated development environment, the Code Editor supplies a matching End

Class statement when you press ENTER.

1. 

Add the following Implements statement to ImplementationClass, which names the interface the class

implements:

When listed separately from other items at the top of a class or structure, the Implements statement indicates that

the class or structure implements an interface.

If you are working within the integrated development environment, the Code Editor implements the class

members required by TestInterface when you press ENTER, and you can skip the next step.

2. 

If you are not working within the integrated development environment, you must implement all the members of

the interface MyInterface. Add the following code to ImplementationClass to implement Event1, Method1,

and Prop1:

The Implements statement names the interface and interface member being implemented.

3. 

Class ImplementationClass

Implements TestInterface

Event Event1() Implements TestInterface.Event1

Public Sub Method1(ByVal X As Integer) Implements TestInterface.Method1

End Sub

Public Property Prop1() As Integer Implements TestInterface.Prop1

Get

End Get

Set(ByVal value As Integer)

End Set

End Property

VB

VB

VB
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Complete the definition of Prop1 by adding a private field to the class that stored the property value:

Return the value of the pval from the property get accessor.

Set the value of pval in the property set accessor.

4. 

Complete the definition of Method1 by adding the following code.5. 

To test the implementation of the interface

Right-click the startup form for your project in the Solution Explorer, and click View Code. The editor displays

the class for your startup form. By default, the startup form is called Form1.

1. 

Add the following testInstance field to the Form1 class:

By declaring testInstance as WithEvents, the Form1 class can handle its events.

2. 

Add the following event handler to the Form1 class to handle events raised by testInstance:3. 

Add a subroutine named Test to the Form1 class to test the implementation class:4. 

' Holds the value of the property.

Private pval As Integer

Return pval

pval = value

MsgBox("The X parameter for Method1 is " & X)

RaiseEvent Event1()

Dim WithEvents testInstance As TestInterface

Sub EventHandler() Handles testInstance.Event1

    MsgBox("The event handler caught the event.")

End Sub

VB

VB

VB

VB
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The Test procedure creates an instance of the class that implements MyInterface, assigns that instance to the

testInstance field, sets a property, and runs a method through the interface.

Add code to call the Test procedure from the Form1 Load procedure of your startup form:5. 

Run the Test procedure by pressing F5. The message "Prop1 was set to 9" is displayed. After you click OK, the

message "The X parameter for Method1 is 5" is displayed. Click OK, and the message "The event handler caught

the event" is displayed.

6. 

See Also
Implements Statement

Interfaces (Visual Basic)

Interface Statement (Visual Basic)

Event Statement

© 2016 Microsoft

Sub Test()

'  Create an instance of the class.

Dim T As New ImplementationClass

' Assign the class instance to the interface.

' Calls to the interface members are 

' executed through the class instance.

    testInstance = T

' Set a property.

    testInstance.Prop1 = 9

' Read the property.

    MsgBox("Prop1 was set to " & testInstance.Prop1)

'  Test the method and raise an event.

    testInstance.Method1(5)

End Sub

Private Sub Form1_Load(ByVal sender As System.Object, 

ByVal e As System.EventArgs) Handles MyBase.Load

    Test() ' Test the class.

End Sub

VB
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Anonymous Types (Visual Basic)

 

Visual Basic supports anonymous types, which enable you to create objects without writing a class definition for the data

type. Instead, the compiler generates a class for you. The class has no usable name, inherits directly from Object, and

contains the properties you specify in declaring the object. Because the name of the data type is not specified, it is referred

to as an anonymous type.

The following example declares and creates variable product as an instance of an anonymous type that has two properties,

Name and Price.

A query expression uses anonymous types to combine columns of data selected by a query. You cannot define the type of

the result in advance, because you cannot predict the columns a particular query might select. Anonymous types enable you

to write a query that selects any number of columns, in any order. The compiler creates a data type that matches the

specified properties and the specified order.

In the following examples, products is a list of product objects, each of which has many properties. Variable

namePriceQuery holds the definition of a query that, when it is executed, returns a collection of instances of an anonymous

type that has two properties, Name and Price.

Variable nameQuantityQuery holds the definition of a query that, when it is executed, returns a collection of instances of an

anonymous type that has two properties, Name and OnHand.

For more information about the code created by the compiler for an anonymous type, see Anonymous Type Definition

(Visual Basic).

Caution

Visual Studio 2015

' Variable product is an instance of a simple anonymous type.

Dim product = New With {Key .Name = "paperclips", .Price = 1.29}

Dim namePriceQuery = From prod In products

Select prod.Name, prod.Price

Dim nameQuantityQuery = From prod In products

Select prod.Name, prod.OnHand

VB

VB

VB

Anonymous Types (Visual Basic) https://msdn.microsoft.com/en-us/library/bb384767(d=printer).aspx

1 of 6 03.09.2016 23:30



The name of the anonymous type is compiler generated and may vary from compilation to compilation. Your code

should not use or rely on the name of an anonymous type because the name might change when a project is recompiled.

Declaring an Anonymous Type
The declaration of an instance of an anonymous type uses an initializer list to specify the properties of the type. You can

specify only properties when you declare an anonymous type, not other class elements such as methods or events. In the

following example, product1 is an instance of an anonymous type that has two properties: Name and Price.

If you designate properties as key properties, you can use them to compare two anonymous type instances for equality.

However, the values of key properties cannot be changed. See the Key Properties section later in this topic for more

information.

Notice that declaring an instance of an anonymous type is like declaring an instance of a named type by using an object

initializer:

For more information about other ways to specify anonymous type properties, see How to: Infer Property Names and

Types in Anonymous Type Declarations (Visual Basic).

Key Properties
Key properties differ from non-key properties in several fundamental ways:

Only the values of key properties are compared in order to determine whether two instances are equal.

The values of key properties are read-only and cannot be changed.

Only key property values are included in the compiler-generated hash code algorithm for an anonymous type.

Equality

Instances of anonymous types can be equal only if they are instances of the same anonymous type. The compiler treats

' Variable product1 is an instance of a simple anonymous type.

Dim product1 = New With {.Name = "paperclips", .Price = 1.29}

' ‐or‐

' product2 is an instance of an anonymous type with key properties.

Dim product2 = New With {Key .Name = "paperclips", Key .Price = 1.29}

' Variable product3 is an instance of a class named Product.

Dim product3 = New Product With {.Name = "paperclips", .Price = 1.29}
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two instances as instances of the same type if they meet the following conditions:

They are declared in the same assembly.

Their properties have the same names, the same inferred types, and are declared in the same order. Name

comparisons are not case-sensitive.

The same properties in each are marked as key properties.

At least one property in each declaration is a key property.

An instance of an anonymous types that has no key properties is equal only to itself.

Two instances of the same anonymous type are equal if the values of their key properties are equal. The following

examples illustrate how equality is tested.

' prod1 and prod2 have no key values.

Dim prod1 = New With {.Name = "paperclips", .Price = 1.29}

Dim prod2 = New With {.Name = "paperclips", .Price = 1.29}

' The following line displays False, because prod1 and prod2 have no

' key properties.

Console.WriteLine(prod1.Equals(prod2))

' The following statement displays True because prod1 is equal to itself.

Console.WriteLine(prod1.Equals(prod1))

Dim prod3 = New With {Key .Name = "paperclips", Key .Price = 1.29}

Dim prod4 = New With {Key .Name = "paperclips", Key .Price = 1.29}

' The following line displays True, because prod3 and prod4 are

' instances of the same anonymous type, and the values of their

' key properties are equal.

Console.WriteLine(prod3.Equals(prod4))

Dim prod5 = New With {Key .Name = "paperclips", Key .Price = 1.29}

Dim prod6 = New With {Key .Name = "paperclips", Key .Price = 1.29,

                      .OnHand = 423}

' The following line displays False, because prod5 and prod6 do not 

' have the same properties.

Console.WriteLine(prod5.Equals(prod6))

Dim prod7 = New With {Key .Name = "paperclips", Key .Price = 1.29,

                      .OnHand = 24}

Dim prod8 = New With {Key .Name = "paperclips", Key .Price = 1.29,

                      .OnHand = 423}

' The following line displays True, because prod7 and prod8 are

' instances of the same anonymous type, and the values of their

' key properties are equal. The equality check does not compare the
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Read-Only Values

The values of key properties cannot be changed. For example, in prod8 in the previous example, the Name and Price

fields are read-only, but OnHand can be changed.

Anonymous Types from Query Expressions
Query expressions do not always require the creation of anonymous types. When possible, they use an existing type to

hold the column data. This occurs when the query returns either whole records from the data source, or only one field

from each record. In the following code examples, customers is a collection of objects of a Customer class. The class has

many properties, and you can include one or more of them in the query result, in any order. In the first two examples, no

anonymous types are required because the queries select elements of named types:

custs1 contains a collection of strings, because cust.Name is a string.

custs2 contains a collection of Customer objects, because each element of customers is a Customer object, and

the whole element is selected by the query.

However, appropriate named types are not always available. You might want to select customer names and addresses for

one purpose, customer ID numbers and locations for another, and customer names, addresses, and order histories for a

third. Anonymous types enable you to select any combination of properties, in any order, without first declaring a new

' values of the non‐key field.

Console.WriteLine(prod7.Equals(prod8))

' The following statement will not compile, because Name is a key

' property and its value cannot be changed.

' prod8.Name = "clamps"

' OnHand is not a Key property. Its value can be changed.

prod8.OnHand = 22

Dim custs1 = From cust In customers

Select cust.Name

Dim custs2 = From cust In customers

Select cust
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named type to hold the result. Instead, the compiler creates an anonymous type for each compilation of properties. The

following query selects only the customer's name and ID number from each Customer object in customers. Therefore,

the compiler creates an anonymous type that contains only those two properties.

Both the names and the data types of the properties in the anonymous type are taken from the arguments to Select,

cust.Name and cust.ID. The properties in an anonymous type that is created by a query are always key properties.

When custs3 is executed in the following For Each loop, the result is a collection of instances of an anonymous type with

two key properties, Name and ID.

The elements in the collection represented by custs3 are strongly typed, and you can use IntelliSense to navigate

through the available properties and to verify their types.

For more information, see Introduction to LINQ in Visual Basic.

Deciding Whether to Use Anonymous Types
Before you create an object as an instance of an anonymous class, consider whether that is the best option. For example, if

you want to create a temporary object to contain related data, and you have no need for other fields and methods that a

complete class might contain, an anonymous type is a good solution. Anonymous types are also convenient if you want a

different selection of properties for each declaration, or if you want to change the order of the properties. However, if

your project includes several objects that have the same properties, in a fixed order, you can declare them more easily by

using a named type with a class constructor. For example, with an appropriate constructor, it is easier to declare several

instances of a Product class than it is to declare several instances of an anonymous type.

Another advantage of named types is that the compiler can catch an accidental mistyping of a property name. In the

Dim custs3 = From cust In customers

Select cust.Name, cust.ID

For Each selectedCust In custs3

    Console.WriteLine(selectedCust.ID & ": " & selectedCust.Name)

Next

' Declaring instances of a named type.

Dim firstProd1 As New Product("paperclips", 1.29)

Dim secondProd1 As New Product("desklamp", 28.99)

Dim thirdProd1 As New Product("stapler", 5.09)

' Declaring instances of an anonymous type.

Dim firstProd2 = New With {Key .Name = "paperclips", Key .Price = 1.29}

Dim secondProd2 = New With {Key .Name = "desklamp", Key .Price = 28.99}

Dim thirdProd2 = New With {Key .Name = "stapler", Key .Price = 5.09}
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previous examples, firstProd2, secondProd2, and thirdProd2 are intended to be instances of the same anonymous

type. However, if you were to accidentally declare thirdProd2 in one of the following ways, its type would be different

from that of firstProd2 and secondProd2.

More importantly, there are limitations on the use of anonymous types that do not apply to instances of named types.

firstProd2, secondProd2, and thirdProd2 are instances of the same anonymous type. However, the name for the

shared anonymous type is not available and cannot appear where a type name is expected in your code. For example, an

anonymous type cannot be used to define a method signature, to declare another variable or field, or in any type

declaration. As a result, anonymous types are not appropriate when you have to share information across methods.

An Anonymous Type Definition
In response to the declaration of an instance of an anonymous type, the compiler creates a new class definition that

contains the specified properties.

If the anonymous type contains at least one key property, the definition overrides three members inherited from Object:

Equals, GetHashCode, and ToString. The code produced for testing equality and determining the hash code value

considers only the key properties. If the anonymous type contains no key properties, only ToString is overridden.

Explicitly named properties of an anonymous type cannot conflict with these generated methods. That is, you cannot use

.Equals, .GetHashCode, or .ToString to name a property.

Anonymous type definitions that have at least one key property also implement the System.IEquatable(Of T) interface,

where T is the type of the anonymous type.

For more information about the code created by the compiler and the functionality of the overridden methods, see

Anonymous Type Definition (Visual Basic).

See Also
Object Initializers: Named and Anonymous Types (Visual Basic)

Local Type Inference (Visual Basic)

Introduction to LINQ in Visual Basic

How to: Infer Property Names and Types in Anonymous Type Declarations (Visual Basic)

Anonymous Type Definition (Visual Basic)

Key (Visual Basic)

© 2016 Microsoft

' Dim thirdProd2 = New With {Key .Nmae = "stapler", Key .Price = 5.09}

' Dim thirdProd2 = New With {Key .Name = "stapler", Key .Price = "5.09"}

' Dim thirdProd2 = New With {Key .Name = "stapler", .Price = 5.09}
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How to: Infer Property Names and Types in
Anonymous Type Declarations (Visual Basic)

 

Anonymous types provide no mechanism for directly specifying the data types of properties. Types of all properties are

inferred. In the following example, the types of Name and Price are inferred directly from the values that are used to

initialize them.

Anonymous types can also infer property names and types from other sources. The sections that follow provide a list of the

circumstances where inference is possible, and examples of situations where it is not.

Successful Inference

Anonymous types can infer property names and types from the following sources:

From variable names. Anonymous type anonProduct will have two properties, productName and productPrice.

Their data types will be those of the original variables, String and Double, respectively.

From property or field names of other objects. For example, consider a car object of a CarClass type that

includes Name and ID properties. To create a new anonymous type instance, car1, with Name and ID properties

that are initialized with the values from the car object, you can write the following:

The previous declaration is equivalent to the longer line of code that defines anonymous type car2.

Visual Studio 2015

' Variable product is an instance of a simple anonymous type.

Dim product = New With {Key .Name = "paperclips", .Price = 1.29}

Dim productName As String = "paperclips"

Dim productPrice As Double = 1.29

Dim anonProduct = New With {Key productName, Key productPrice}

' To create uppercase variable names for the new properties,

' assign variables productName and productPrice to uppercase identifiers.

Dim anonProduct1 = New With {Key .Name = productName, Key .Price = productPrice}

Dim car1 = New With {Key car.Name, Key car.ID}
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From XML member names.

The resulting type for anon would have one property, Book, of type IEnumerable(Of XElement).

From a function that has no parameters, such as SomeFunction in the following example.

Dim sc As New SomeClass

Dim anon1 = New With {Key sc.SomeFunction()}

The variable anon2 in the following code is an anonymous type that has one property, a character named First.

This code will display a letter "E," the letter that is returned by function First(Of TSource).

Inference Failures

Name inference will fail in many circumstances, including the following:

The inference derives from the invocation of a method, a constructor, or a parameterized property that requires

arguments. The previous declaration of anon1 fails if someFunction has one or more arguments.

' Not valid.

' Dim anon3 = New With {Key sc.someFunction(someArg)}

Assignment to a new property name solves the problem.

' Valid.

Dim car2 = New With {Key .Name = car.Name, Key .ID = car.ID}

Dim books = <Books>

                <Book Author="Jesper Aaberg">

                    Advanced Programming Methods

                </Book>

            </Books>

Dim anon = New With {books...<Book>}

Dim aString As String = "Example String"

Dim anon2 = New With {Key aString.First()}

' The variable anon2 has one property, First.

Console.WriteLine(anon2.First)
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Dim anon4 = New With {Key .FunResult = sc.someFunction(someArg)}

The inference derives from a complex expression.

The error can be resolved by assigning the result of the expression to a property name.

Inference for multiple properties produces two or more properties that have the same name. Referring back to

declarations in earlier examples, you cannot list both product.Name and car1.Name as properties of the same

anonymous type. This is because the inferred identifier for each of these would be Name.

' Not valid.

' Dim anon5 = New With {Key product.Name, Key car1.Name}

The problem can be solved by assigning the values to distinct property names.

Note that changes in case (changes between uppercase and lowercase letters) do not make two names distinct.

Dim price = 0

' Not valid, because Price and price are the same name.

' Dim anon7 = New With {Key product.Price, Key price}

The initial type and value of one property depends on another property that is not yet established. For example,

.IDName = .LastName is not valid in an anonymous type declaration unless .LastName is already initialized.

' Not valid.

' Dim anon8 = New With {Key .IDName = .LastName, Key .LastName = "Jones"}

In this example, you can fix the problem by reversing the order in which the properties are declared.

Dim aString As String = "Act "

' Not valid.

' Dim label = New With {Key aString & "IV"}

' Valid.

Dim label1 = New With {Key .someLabel = aString & "IV"}

' Valid.

Dim anon6 = New With {Key .ProductName = product.Name, Key .CarName = car1.Name}

' Valid.
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A property name of the anonymous type is the same as the name of a member of Object. For example, the

following declaration fails because Equals is a method of Object.

' Not valid.

' Dim relationsLabels1 = New With {Key .Equals = "equals", Key .Greater = _

' "greater than", Key .Less = "less than"}

You can fix the problem by changing the property name:

See Also
Object Initializers: Named and Anonymous Types (Visual Basic)

Local Type Inference (Visual Basic)

Anonymous Types (Visual Basic)

Key (Visual Basic)

© 2016 Microsoft

Dim anon9 = New With {Key .LastName = "Jones", Key .IDName = .LastName}

' Valid 

Dim relationsLabels2 = New With {Key .EqualString = "equals",

                                 Key .GreaterString = "greater than",

                                 Key .LessString = "less than"}
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Anonymous Type Definition (Visual Basic)

 

In response to the declaration of an instance of an anonymous type, the compiler creates a new class definition that contains

the specified properties for the type.

Compiler-Generated Code
For the following definition of product, the compiler creates a new class definition that contains properties Name, Price,

and OnHand.

The class definition contains property definitions similar to the following. Notice that there is no Set method for the key

properties. The values of key properties are read-only.

Visual Studio 2015

' Variable product is an instance of an anonymous type.

Dim product = New With {Key .Name = "paperclips", Key .Price = 1.29, .OnHand = 24}
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In addition, anonymous type definitions contain a default constructor. Constructors that require parameters are not

permitted.

If an anonymous type declaration contains at least one key property, the type definition overrides three members

inherited from Object: Equals, GetHashCode, and ToString. If no key properties are declared, only ToString is overridden.

The overrides provide the following functionality:

Equals returns True if two anonymous type instances are the same instance, or if they meet the following

conditions:

They have the same number of properties.

The properties are declared in the same order, with the same names and the same inferred types. Name

comparisons are not case-sensitive.

At least one of the properties is a key property, and the Key keyword is applied to the same properties.

Comparison of each corresponding pair of key properties returns True.

For example, in the following examples, Equals returns True only for employee01 and employee08. The comment

before each line specifies the reason why the new instance does not match employee01.

Public Class $Anonymous1

Private _name As String

Private _price As Double

Private _onHand As Integer

Public ReadOnly Property Name() As String

Get

Return _name

End Get

End Property

Public ReadOnly Property Price() As Double

Get

Return _price

End Get

End Property

Public Property OnHand() As Integer

Get

Return _onHand

End Get

Set(ByVal Value As Integer)

            _onHand = Value

End Set

End Property

End Class

Dim employee01 = New With {Key .Name = "Bob", Key .Category = 3, .InOffice = False}
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GetHashcode provides an appropriately unique GetHashCode algorithm. The algorithm uses only the key

properties to compute the hash code.

ToString returns a string of concatenated property values, as shown in the following example. Both key and

non-key properties are included.

Explicitly named properties of an anonymous type cannot conflict with these generated methods. That is, you cannot use

.Equals, .GetHashCode, or .ToString to name a property.

Anonymous type definitions that include at least one key property also implement the System.IEquatable(Of T) interface,

where T is the type of the anonymous type.

Note

' employee02 has no InOffice property.

Dim employee02 = New With {Key .Name = "Bob", Key .Category = 3}

' The first property has a different name.

Dim employee03 = New With {Key .FirstName = "Bob", Key .Category = 3, .InOffice = 

False}

' Property Category has a different value.

Dim employee04 = New With {Key .Name = "Bob", Key .Category = 2, .InOffice = False}

' Property Category has a different type.

Dim employee05 = New With {Key .Name = "Bob", Key .Category = 3.2, .InOffice = 

False}

' The properties are declared in a different order.

Dim employee06 = New With {Key .Category = 3, Key .Name = "Bob", .InOffice = False}

' Property Category is not a key property.

Dim employee07 = New With {Key .Name = "Bob", .Category = 3, .InOffice = False}

' employee01 and employee 08 meet all conditions for equality. Note 

' that the values of the non‐key field need not be the same.

Dim employee08 = New With {Key .Name = "Bob", Key .Category = 2 + 1, .InOffice = 

True}

' Equals returns True only for employee01 and employee08.

Console.WriteLine(employee01.Equals(employee08))

Console.WriteLine(employee01.ToString())

Console.WriteLine(employee01)

' The preceding statements both display the following:

' { Name = Bob, Category = 3, InOffice = False }
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Anonymous type declarations create the same anonymous type only if they occur in the same assembly, their

properties have the same names and the same inferred types, the properties are declared in the same order, and the

same properties are marked as key properties.

See Also
Anonymous Types (Visual Basic)

How to: Infer Property Names and Types in Anonymous Type Declarations (Visual Basic)

© 2016 Microsoft
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Object Initializers: Named and Anonymous
Types (Visual Basic)

 

Object initializers enable you to specify properties for a complex object by using a single expression. They can be used to

create instances of named types and of anonymous types.

Declarations
Declarations of instances of named and anonymous types can look almost identical, but their effects are not the same.

Each category has abilities and restrictions of its own. The following example shows a convenient way to declare and

initialize an instance of a named class, Customer, by using an object initializer list. Notice that the name of the class is

specified after the keyword New.

An anonymous type has no usable name. Therefore an instantiation of an anonymous type cannot include a class name.

The requirements and results of the two declarations are not the same. For namedCust, a Customer class that has a Name

property must already exist, and the declaration creates an instance of that class. For anonymousCust, the compiler

defines a new class that has one property, a string called Name, and creates a new instance of that class.

Named Types
Object initializers provide a simple way to call the constructor of a type and then set the values of some or all properties

in a single statement. The compiler invokes the appropriate constructor for the statement: the default constructor if no

arguments are presented, or a parameterized constructor if one or more arguments are sent. After that, the specified

properties are initialized in the order in which they are presented in the initializer list.

Each initialization in the initializer list consists of the assignment of an initial value to a member of the class. The names

and data types of the members are determined when the class is defined. In the following examples, the Customer class

must exist, and must have members named Name and City that can accept string values.

Visual Studio 2015

Dim namedCust = New Customer With {.Name = "Terry Adams"}

Dim anonymousCust = New With {.Name = "Hugo Garcia"}

Dim cust0 As Customer = New Customer With {.Name = "Toni Poe", 
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Alternatively, you can obtain the same result by using the following code:

Each of these declarations is equivalent to the following example, which creates a Customer object by using the default

constructor, and then specifies initial values for the Name and City properties by using a With statement.

If the Customer class contains a parameterized constructor that enables you to send in a value for Name, for example, you

can also declare and initialize a Customer object in the following ways:

You do not have to initialize all properties, as the following code shows.

However, the initialization list cannot be empty. Uninitialized properties retain their default values.

Type Inference with Named Types

                                           .City = "Louisville"}

Dim cust1 As New Customer With {.Name = "Toni Poe", 

                                .City = "Louisville"}

Dim cust2 As New Customer()

With cust2

    .Name = "Toni Poe"

    .City = "Louisville"

End With

Dim cust3 As Customer = 

New Customer("Toni Poe") With {.City = "Louisville"}

' ‐‐or‐‐

Dim cust4 As New Customer("Toni Poe") With {.City = "Louisville"}

Dim cust5 As Customer = New Customer With {.Name = "Toni Poe"}
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You can shorten the code for the declaration of cust1 by combining object initializers and local type inference. This

enables you to omit the As clause in the variable declaration. The data type of the variable is inferred from the type of

the object that is created by the assignment. In the following example, the type of cust6 is Customer.

Remarks About Named Types

A class member cannot be initialized more than one time in the object initializer list. The declaration of cust7

causes an error.

A member can be used to initialize itself or another field. If a member is accessed before it has been initialized, as

in the following declaration for cust8, the default value will be used. Remember that when a declaration that

uses an object initializer is processed, the first thing that happens is that the appropriate constructor is invoked.

After that, the individual fields in the initializer list are initialized. In the following examples, the default value for

Name is assigned for cust8, and an initialized value is assigned in cust9.

The following example uses the parameterized constructor from cust3 and cust4 to declare and initialize

cust10 and cust11.

Object initializers can be nested. In the following example, AddressClass is a class that has two properties,

City and State, and the Customer class has an Address property that is an instance of AddressClass.

Dim cust6 = New Customer With {.Name = "Toni Poe", 

                               .City = "Louisville"}

'' This code does not compile because Name is initialized twice.

' Dim cust7 = New Customer With {.Name = "Toni Poe", 

'                                .City = "Louisville",

'                                .Name = "Blue Yonder Airlines"}

Dim cust8 = New Customer With {.Name = .Name & ", President"}

Dim cust9 = New Customer With {.Name = "Toni Poe", 

                               .Title = .Name & ", President"}

Dim cust10 = New Customer("Toni Poe") With {.Name = .Name & ", President"}

' ‐‐or‐‐

Dim cust11 As New Customer("Toni Poe") With {.Name = .Name & ", President"}

Dim cust12 = 
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The initialization list cannot be empty.

The instance being initialized cannot be of type Object.

Class members being initialized cannot be shared members, read-only members, constants, or method calls.

Class members being initialized cannot be indexed or qualified. The following examples raise compiler errors:

'' Not valid.

' Dim c1 = New Customer With {.OrderNumbers(0) = 148662}

' Dim c2 = New Customer with {.Address.City = "Springfield"}

Anonymous Types
Anonymous types use object initializers to create instances of new types that you do not explicitly define and name.

Instead, the compiler generates a type according to the properties you designate in the object initializer list. Because the

name of the type is not specified, it is referred to as an anonymous type. For example, compare the following declaration

to the earlier one for cust6.

The only difference syntactically is that no name is specified after New for the data type. However, what happens is quite

different. The compiler defines a new anonymous type that has two properties, Name and City, and creates an instance of

it with the specified values. Type inference determines the types of Name and City in the example to be strings.

Caution

The name of the anonymous type is generated by the compiler, and may vary from compilation to compilation. Your

code should not use or rely on the name of an anonymous type.

Because the name of the type is not available, you cannot use an As clause to declare cust13. Its type must be inferred.

Without using late binding, this limits the use of anonymous types to local variables.

Anonymous types provide critical support for LINQ queries. For more information about the use of anonymous types in

New Customer With {.Name = "Toni Poe", 

                       .Address = 

New AddressClass With {.City = "Louisville", 

                                                  .State = "Kentucky"}}

Console.WriteLine(cust12.Address.State)

Dim cust13 = New With {.Name = "Toni Poe", 

                       .City = "Louisville"}

VB
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queries, see Anonymous Types (Visual Basic) and Introduction to LINQ in Visual Basic. 

Remarks About Anonymous Types

Typically, all or most of the properties in an anonymous type declaration will be key properties, which are

indicated by typing the keyword Key in front of the property name.

For more information about key properties, see Key (Visual Basic).

Like named types, initializer lists for anonymous type definitions must declare at least one property.

When an instance of an anonymous type is declared, the compiler generates a matching anonymous type

definition. The names and data types of the properties are taken from the instance declaration, and are included

by the compiler in the definition. The properties are not named and defined in advance, as they would be for a

named type. Their types are inferred. You cannot specify the data types of the properties by using an As clause.

Anonymous types can also establish the names and values of their properties in several other ways. For example,

an anonymous type property can take both the name and the value of a variable, or the name and value of a

property of another object.

For more information about the options for defining properties in anonymous types, see How to: Infer Property

Names and Types in Anonymous Type Declarations (Visual Basic).

Dim anonymousCust1 = New With {Key .Name = "Hugo Garcia", 

                               Key .City = "Louisville"}

Dim anonymousCust = New With {.Name = "Hugo Garcia"}

' Create a variable, Name, and give it an initial value.

Dim Name = "Hugo Garcia"

' Variable anonymousCust2 will have one property, Name, with 

' "Hugo Garcia" as its initial value.

Dim anonymousCust2 = New With {Key Name}

' The next declaration uses a property from namedCust, defined

' in an earlier example. After the declaration, anonymousCust3 will

' have one property, Name, with "Terry Adams" as its value.

Dim anonymousCust3 = New With {Key namedCust.Name}

VB

VB

VB

Object Initializers: Named and Anonymous Types (Visual Basic) https://msdn.microsoft.com/en-us/library/bb385125(d=printer).aspx

5 of 6 03.09.2016 23:33



See Also
Local Type Inference (Visual Basic)

Anonymous Types (Visual Basic)

Introduction to LINQ in Visual Basic

How to: Infer Property Names and Types in Anonymous Type Declarations (Visual Basic)

Key (Visual Basic)

How to: Declare an Object by Using an Object Initializer (Visual Basic)

© 2016 Microsoft
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Walkthrough: Writing Queries in Visual Basic

 

This walkthrough demonstrates how you can use Visual Basic language features to write Language-Integrated Query (LINQ)

query expressions. The walkthrough demonstrates how to create queries on a list of Student objects, how to run the queries,

and how to modify them. The queries incorporate several features including object initializers, local type inference, and

anonymous types.

After completing this walkthrough, you will be ready to move on to the samples and documentation for the specific LINQ

provider you are interested in. LINQ providers include LINQ to SQL, LINQ to DataSet, and LINQ to XML.

Create a Project

To create a console application project

Start Visual Studio.1. 

On the File menu, point to New, and then click Project.2. 

In the Installed Templates list, click Visual Basic.3. 

In the list of project types, click Console Application. In the Name box, type a name for the project, and then click

OK.

A project is created. By default, it contains a reference to System.Core.dll. Also, the Imported namespaces list on

the References Page, Project Designer (Visual Basic) includes the System.Linq namespace.

4. 

On the Compile Page, Project Designer (Visual Basic), ensure that Option infer is set to On.5. 

Add an In-Memory Data Source
The data source for the queries in this walkthrough is a list of Student objects. Each Student object contains a first name,

a last name, a class year, and an academic rank in the student body.

To add the data source

Define a Student class, and create a list of instances of the class.

Important

The code needed to define the Student class and create the list used in the walkthrough examples is provided

in How to: Create a List of Items. You can copy it from there and paste it into your project. The new code

Visual Studio 2015
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replaces the code that appeared when you created the project.

To add a new student to the students list

Follow the pattern in the getStudents method to add another instance of the Student class to the list. Adding

the student will introduce you to object initializers. For more information, see Object Initializers: Named and

Anonymous Types (Visual Basic).

Create a Query
When executed, the query added in this section produces a list of the students whose academic rank puts them in the top

ten. Because the query selects the complete Student object each time, the type of the query result is IEnumerable(Of

Student). However, the type of the query typically is not specified in query definitions. Instead, the compiler uses local

type inference to determine the type. For more information, see Local Type Inference (Visual Basic). The query's range

variable, currentStudent, serves as a reference to each Student instance in the source, students, providing access to

the properties of each object in students.

To create a simple query

Find the place in the Main method of the project that is marked as follows:

Copy the following code and paste it in.

1. 

Rest the mouse pointer over studentQuery in your code to verify that the compiler-assigned type is

IEnumerable(Of Student).

2. 

Run the Query
The variable studentQuery contains the definition of the query, not the results of running the query. A typical

mechanism for running a query is a For Each loop. Each element in the returned sequence is accessed through the loop

iteration variable. For more information about query execution, see Writing Your First LINQ Query (Visual Basic).

' ****Paste query and query execution code from the walkthrough,

' ****or any code of your own, here in Main.

Dim studentQuery = From currentStudent In students

Where currentStudent.Rank <= 10

Select currentStudent

VB

VB
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To run the query

Add the following For Each loop below the query in your project.1. 

Rest the mouse pointer over the loop control variable studentRecord to see its data type. The type of

studentRecord is inferred to be Student, because studentQuery returns a collection of Student instances.

2. 

Build and run the application by pressing CTRL+F5. Note the results in the console window.3. 

Modify the Query
It is easier to scan query results if they are in a specified order. You can sort the returned sequence based on any available

field.

To order the results

Add the following Order By clause between the Where statement and the Select statement of the query. The

Order By clause will order the results alphabetically from A to Z, according to the last name of each student.

1. 

To order by last name and then first name, add both fields to the query:

You can also specify Descending to order from Z to A.

2. 

Build and run the application by pressing CTRL+F5. Note the results in the console window.3. 

To introduce a local identifier

Add the code in this section to introduce a local identifier in the query expression. The local identifier will hold an

intermediate result. In the following example, name is an identifier that holds a concatenation of the student's first

and last names. A local identifier can be used for convenience, or it can enhance performance by storing the results

of an expression that would otherwise be calculated multiple times.

1. 

For Each studentRecord In studentQuery

    Console.WriteLine(studentRecord.Last & ", " & studentRecord.First)

Next

Order By currentStudent.Last Ascending 

Order By currentStudent.Last Ascending, currentStudent.First Ascending 

VB

VB
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Build and run the application by pressing CTRL+F5. Note the results in the console window.2. 

To project one field in the Select clause

Add the query and For Each loop from this section to create a query that produces a sequence whose elements

differ from the elements in the source. In the following example, the source is a collection of Student objects, but

only one member of each object is returned: the first name of students whose last name is Garcia. Because

currentStudent.First is a string, the data type of the sequence returned by studentQuery3 is

IEnumerable(Of String), a sequence of strings. As in earlier examples, the assignment of a data type for

studentQuery3 is left for the compiler to determine by using local type inference.

1. 

Rest the mouse pointer over studentQuery3 in your code to verify that the assigned type is IEnumerable(Of

String).

2. 

Build and run the application by pressing CTRL+F5. Note the results in the console window.3. 

To create an anonymous type in the Select clause

Add the code from this section to see how anonymous types are used in queries. You use them in queries when

you want to return several fields from the data source rather than complete records (currentStudent records in

previous examples) or single fields (First in the preceding section). Instead of defining a new named type that

contains the fields you want to include in the result, you specify the fields in the Select clause and the compiler

creates an anonymous type with those fields as its properties. For more information, see Anonymous Types (Visual

1. 

Dim studentQuery2 =

From currentStudent In students

Let name = currentStudent.Last & ", " & currentStudent.First

Where currentStudent.Year = "Senior" And currentStudent.Rank <= 10

Order By name Ascending

Select currentStudent

' If you see too many results, comment out the previous

' For Each loop.

For Each studentRecord In studentQuery2

    Console.WriteLine(studentRecord.Last & ", " & studentRecord.First)

Next

Dim studentQuery3 = From currentStudent In students

Where currentStudent.Last = "Garcia"

Select currentStudent.First

' If you see too many results, comment out the previous

' For Each loops.

For Each studentRecord In studentQuery3

    Console.WriteLine(studentRecord)

Next

VB
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Basic).

The following example creates a query that returns the name and rank of seniors whose academic rank is between 1

and 10, in order of academic rank. In this example, the type of studentQuery4 must be inferred because the

Select clause returns an instance of an anonymous type, and an anonymous type has no usable name.

Build and run the application by pressing CTRL+F5. Note the results in the console window.2. 

Additional Examples
Now that you understand the basics, the following is a list of additional examples to illustrate the flexibility and power of

LINQ queries. Each example is preceded by a brief description of what it does. Rest the mouse pointer over the query

result variable for each query to see the inferred type. Use a For Each loop to produce the results.

Dim studentQuery4 =

From currentStudent In students

Where currentStudent.Year = "Senior" And currentStudent.Rank <= 10

Order By currentStudent.Rank Ascending

Select currentStudent.First, currentStudent.Last, currentStudent.Rank

' If you see too many results, comment out the previous

' For Each loops.

For Each studentRecord In studentQuery4

    Console.WriteLine(studentRecord.Last & ", " & studentRecord.First &

":  " & studentRecord.Rank)

Next

' Find all students who are seniors.

Dim q1 = From currentStudent In students

Where currentStudent.Year = "Senior"

Select currentStudent

' Write a For Each loop to execute the query.

For Each q In q1

    Console.WriteLine(q.First & " " & q.Last)

Next

' Find all students with a first name beginning with "C".

Dim q2 = From currentStudent In students

Where currentStudent.First.StartsWith("C")

Select currentStudent

' Find all top ranked seniors (rank < 40).

Dim q3 = From currentStudent In students

Where currentStudent.Rank < 40 And currentStudent.Year = "Senior"

Select currentStudent

VB

VB
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Additional Information
After you are familiar with the basic concepts of working with queries, you are ready to read the documentation and

samples for the specific type of LINQ provider that you are interested in:

' Find all seniors with a lower rank than a student who 

' is not a senior.

Dim q4 = From student1 In students, student2 In students

Where student1.Year = "Senior" And student2.Year <> "Senior" And

               student1.Rank > student2.Rank

Select student1

Distinct

' Retrieve the full names of all students, sorted by last name.

Dim q5 = From currentStudent In students

Order By currentStudent.Last

Select Name = currentStudent.First & " " & currentStudent.Last

' Determine how many students are ranked in the top 20.

Dim q6 = Aggregate currentStudent In students

Where currentStudent.Rank <= 20

Into Count()

' Count the number of different last names in the group of students.

Dim q7 = Aggregate currentStudent In students

Select currentStudent.Last

Distinct

Into Count()

' Create a list box to show the last names of students.

Dim lb As New System.Windows.Forms.ListBox

Dim q8 = From currentStudent In students

Order By currentStudent.Last

Select currentStudent.Last Distinct

For Each nextName As String In q8

    lb.Items.Add(nextName)

Next

' Find every process that has a lowercase "h", "l", or "d" in its name.

Dim letters() As String = {"h", "l", "d"}

Dim q9 = From proc In System.Diagnostics.Process.GetProcesses,

         letter In letters

Where proc.ProcessName.Contains(letter)

Select proc

For Each proc In q9

    Console.WriteLine(proc.ProcessName & ", " & proc.WorkingSet64)

Next
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LINQ to Objects

LINQ to SQL

LINQ to XML

LINQ to DataSet

See Also
Language-Integrated Query (LINQ) (Visual Basic)

Getting Started with LINQ in Visual Basic

Local Type Inference (Visual Basic)

Object Initializers: Named and Anonymous Types (Visual Basic)

Anonymous Types (Visual Basic)

Introduction to LINQ in Visual Basic

LINQ in Visual Basic

Queries (Visual Basic)
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Walkthrough: Implementing IEnumerable(Of
T) in Visual Basic

 

The IEnumerable(Of T) interface is implemented by classes that can return a sequence of values one item at a time. The

advantage of returning data one item at a time is that you do not have to load the complete set of data into memory to

work with it. You only have to use sufficient memory to load a single item from the data. Classes that implement the

IEnumerable(T) interface can be used with For Each loops or LINQ queries.

For example, consider an application that must read a large text file and return each line from the file that matches particular

search criteria. The application uses a LINQ query to return lines from the file that match the specified criteria. To query the

contents of the file by using a LINQ query, the application could load the contents of the file into an array or a collection.

However, loading the whole file into an array or collection would consume far more memory than is required. The LINQ

query could instead query the file contents by using an enumerable class, returning only values that match the search

criteria. Queries that return only a few matching values would consume far less memory.

You can create a class that implements the IEnumerable(Of T) interface to expose source data as enumerable data. Your class

that implements the IEnumerable(T) interface will require another class that implements the IEnumerator(Of T) interface to

iterate through the source data. These two classes enable you to return items of data sequentially as a specific type.

In this walkthrough, you will create a class that implements the IEnumerable(Of String) interface and a class that

implements the IEnumerator(Of String) interface to read a text file one line at a time.

Note

Your computer might show different names or locations for some of the Visual Studio user interface elements in the

following instructions. The Visual Studio edition that you have and the settings that you use determine these elements.

For more information, see Personalizing the Visual Studio IDE.

Creating the Enumerable Class

To create the enumerable class project

In Visual Basic, on the File menu, point to New and then click Project.1. 

In the New Project dialog box, in the Project Types pane, make sure that Windows is selected. Select Class

Library in the Templates pane. In the Name box, type StreamReaderEnumerable, and then click OK. The new

project is displayed.

2. 

In Solution Explorer, right-click the Class1.vb file and click Rename. Rename the file to

StreamReaderEnumerable.vb and press ENTER. Renaming the file will also rename the class to

StreamReaderEnumerable. This class will implement the IEnumerable(Of String) interface.

3. 

Visual Studio 2015
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Right-click the StreamReaderEnumerable project, point to Add, and then click New Item. Select the Class

template. In the Name box, type StreamReaderEnumerator.vb and click OK.

4. 

The first class in this project is the enumerable class and will implement the IEnumerable(Of String) interface. This

generic interface implements the IEnumerable interface and guarantees that consumers of this class can access values

typed as String.

To add the code to implement IEnumerable

Open the StreamReaderEnumerable.vb file.1. 

On the line after Public Class StreamReaderEnumerable, type the following and press ENTER.

Visual Basic automatically populates the class with the members that are required by the IEnumerable(Of

String) interface.

2. 

This enumerable class will read lines from a text file one line at a time. Add the following code to the class to

expose a public constructor that takes a file path as an input parameter.

3. 

Your implementation of the GetEnumerator method of the IEnumerable(Of String) interface will return a new

instance of the StreamReaderEnumerator class. The implementation of the GetEnumerator method of the

IEnumerable interface can be made Private, because you have to expose only members of the

IEnumerable(Of String) interface. Replace the code that Visual Basic generated for the GetEnumerator

methods with the following code.

4. 

Implements IEnumerable(Of String)

Private _filePath As String

Public Sub New(ByVal filePath As String)

    _filePath = filePath

End Sub

Public Function GetEnumerator() As IEnumerator(Of String) _

Implements IEnumerable(Of String).GetEnumerator

Return New StreamReaderEnumerator(_filePath)

End Function

Private Function GetEnumerator1() As IEnumerator _

Implements IEnumerable.GetEnumerator

Return Me.GetEnumerator()

VB

VB

VB

Walkthrough: Implementing IEnumerable(Of T) in Visual Basic https://msdn.microsoft.com/en-us/library/dd145423(d=printer)

2 of 5 03.09.2016 23:35



To add the code to implement IEnumerator

Open the StreamReaderEnumerator.vb file.1. 

On the line after Public Class StreamReaderEnumerator, type the following and press ENTER.

Visual Basic automatically populates the class with the members that are required by the IEnumerator(Of

String) interface.

2. 

The enumerator class opens the text file and performs the file I/O to read the lines from the file. Add the

following code to the class to expose a public constructor that takes a file path as an input parameter and open

the text file for reading.

3. 

The Current properties for both the IEnumerator(Of String) and IEnumerator interfaces return the current

item from the text file as a String. The implementation of the Current property of the IEnumerator interface

can be made Private, because you have to expose only members of the IEnumerator(Of String) interface.

Replace the code that Visual Basic generated for the Current properties with the following code.

4. 

End Function

Implements IEnumerator(Of String)

Private _sr As IO.StreamReader

Public Sub New(ByVal filePath As String)

    _sr = New IO.StreamReader(filePath)

End Sub

Private _current As String

Public ReadOnly Property Current() As String _

Implements IEnumerator(Of String).Current

Get

If _sr Is Nothing OrElse _current Is Nothing Then

Throw New InvalidOperationException()

End If

Return _current

End Get

End Property

Private ReadOnly Property Current1() As Object _

VB

VB
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The MoveNext method of the IEnumerator interface navigates to the next item in the text file and updates the

value that is returned by the Current property. If there are no more items to read, the MoveNext method

returns False; otherwise the MoveNext method returns True. Add the following code to the MoveNext

method.

5. 

The Reset method of the IEnumerator interface directs the iterator to point to the start of the text file and

clears the current item value. Add the following code to the Reset method.

6. 

The Dispose method of the IEnumerator interface guarantees that all unmanaged resources are released

before the iterator is destroyed. The file handle that is used by the StreamReader object is an unmanaged

resource and must be closed before the iterator instance is destroyed. Replace the code that Visual Basic

generated for the Dispose method with the following code.

7. 

Implements IEnumerator.Current

Get

Return Me.Current

End Get

End Property

Public Function MoveNext() As Boolean _

Implements System.Collections.IEnumerator.MoveNext

    _current = _sr.ReadLine()

If _current Is Nothing Then Return False

Return True

End Function

Public Sub Reset() _

Implements System.Collections.IEnumerator.Reset

    _sr.DiscardBufferedData()

    _sr.BaseStream.Seek(0, IO.SeekOrigin.Begin)

    _current = Nothing

End Sub

Private disposedValue As Boolean = False

Protected Overridable Sub Dispose(ByVal disposing As Boolean)

If Not Me.disposedValue Then

If disposing Then

' Dispose of managed resources.

End If

        _current = Nothing

VB

VB
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Using the Sample Iterator
You can use an enumerable class in your code together with control structures that require an object that implements

IEnumerable, such as a For Next loop or a LINQ query. The following example shows the StreamReaderEnumerable in

a LINQ query.

See Also
Introduction to LINQ in Visual Basic

Control Flow in Visual Basic

Loop Structures (Visual Basic)

For Each...Next Statement (Visual Basic)

© 2016 Microsoft

        _sr.Close()

        _sr.Dispose()

End If

Me.disposedValue = True

End Sub

Public Sub Dispose() Implements IDisposable.Dispose

    Dispose(True)

    GC.SuppressFinalize(Me)

End Sub

Protected Overrides Sub Finalize()

    Dispose(False)

End Sub

Dim adminRequests = 

From line In New StreamReaderEnumerable("..\..\log.txt")

Where line.Contains("admin.aspx 401")

Dim results = adminRequests.ToList()

VB
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Walkthrough: Calling Windows APIs (Visual
Basic)

 

Windows APIs are dynamic-link libraries (DLLs) that are part of the Windows operating system. You use them to perform

tasks when it is difficult to write equivalent procedures of your own. For example, Windows provides a function named

FlashWindowEx that lets you make the title bar for an application alternate between light and dark shades.

The advantage of using Windows APIs in your code is that they can save development time because they contain dozens of

useful functions that are already written and waiting to be used. The disadvantage is that Windows APIs can be difficult to

work with and unforgiving when things go wrong.

Windows APIs represent a special category of interoperability. Windows APIs do not use managed code, do not have

built-in type libraries, and use data types that are different than those used with Visual Studio. Because of these differences,

and because Windows APIs are not COM objects, interoperability with Windows APIs and the .NET Framework is performed

using platform invoke, or PInvoke. Platform invoke is a service that enables managed code to call unmanaged functions

implemented in DLLs. For more information, see Consuming Unmanaged DLL Functions. You can use PInvoke in Visual Basic

by using either the Declare statement or applying the DllImport attribute to an empty procedure.

Windows API calls were an important part of Visual Basic programming in the past, but are seldom necessary with Visual

Basic 2005. Whenever possible, you should use managed code from the .NET Framework to perform tasks, instead of

Windows API calls. This walkthrough provides information for those situations in which using Windows APIs is necessary.

Note

Your computer might show different names or locations for some of the Visual Studio user interface elements in the

following instructions. The Visual Studio edition that you have and the settings that you use determine these elements.

For more information, see Personalizing the Visual Studio IDE.

API Calls Using Declare
The most common way to call Windows APIs is by using the Declare statement.

To declare a DLL procedure

Determine the name of the function you want to call, plus its arguments, argument types, and return value, as well

as the name and location of the DLL that contains it.

Note

1. 
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For complete information about the Windows APIs, see the Win32 SDK documentation in the Platform SDK

Windows API. For more information about the constants that Windows APIs use, examine the header files such

as Windows.h included with the Platform SDK.

Open a new Windows Application project by clicking New on the File menu, and then clicking Project. The New

Project dialog box appears.

2. 

Select Windows Application from the list of Visual Basic project templates. The new project is displayed.3. 

Add the following Declare function either to the class or module in which you want to use the DLL:4. 

Parts of the Declare Statement

The Declare statement includes the following elements.

Auto modifier

The Auto modifier instructs the runtime to convert the string based on the method name according to common

language runtime rules (or alias name if specified).

Lib and Alias keywords

The name following the Function keyword is the name your program uses to access the imported function. It can be

the same as the real name of the function you are calling, or you can use any valid procedure name and then employ

the Alias keyword to specify the real name of the function you are calling.

Specify the Lib keyword, followed by the name and location of the DLL that contains the function you are calling.

You do not need to specify the path for files located in the Windows system directories.

Use the Alias keyword if the name of the function you are calling is not a valid Visual Basic procedure name, or

conflicts with the name of other items in your application. Alias indicates the true name of the function being called.

Argument and Data Type Declarations

Declare the arguments and their data types. This part can be challenging because the data types that Windows uses

do not correspond to Visual Studio data types. Visual Basic does a lot of the work for you by converting arguments

to compatible data types, a process called marshaling. You can explicitly control how arguments are marshaled by

using the MarshalAsAttribute attribute defined in the System.Runtime.InteropServices namespace.

Declare Auto Function MBox Lib "user32.dll" Alias "MessageBox" (

ByVal hWnd As Integer,

ByVal txt As String,

ByVal caption As String,

ByVal Typ As Integer) As Integer

VB
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Note

Previous versions of Visual Basic allowed you to declare parameters As Any, meaning that data of any data type

could be used. Visual Basic requires that you use a specific data type for all Declare statements.

Windows API Constants

Some arguments are combinations of constants. For example, the MessageBox API shown in this walkthrough

accepts an integer argument called Typ that controls how the message box is displayed. You can determine the

numeric value of these constants by examining the #define statements in the file WinUser.h. The numeric values are

generally shown in hexadecimal, so you may want to use a calculator to add them and convert to decimal. For

example, if you want to combine the constants for the exclamation style MB_ICONEXCLAMATION 0x00000030 and the

Yes/No style MB_YESNO 0x00000004, you can add the numbers and get a result of 0x00000034, or 52 decimal.

Although you can use the decimal result directly, it is better to declare these values as constants in your application

and combine them using the Or operator.

To declare constants for Windows API calls

Consult the documentation for the Windows function you are calling. Determine the name of the constants it

uses and the name of the .h file that contains the numeric values for these constants.

1. 

Use a text editor, such as Notepad, to view the contents of the header (.h) file, and find the values associated

with the constants you are using. For example, the MessageBox API uses the constant MB_ICONQUESTION to

show a question mark in the message box. The definition for MB_ICONQUESTION is in WinUser.h and appears

as follows:

#define MB_ICONQUESTION 0x00000020L

2. 

Add equivalent Const statements to your class or module to make these constants available to your

application. For example:

3. 

To call the DLL procedure

Add a button named Button1 to the startup form for your project, and then double-click it to view its code.

The event handler for the button is displayed.

1. 

Add code to the Click event handler for the button you added, to call the procedure and provide the

appropriate arguments:

2. 

Const MB_ICONQUESTION As Integer = &H20

Const MB_YESNO As Integer = &H4

Const IDYES As Integer = 6

Const IDNO As Integer = 7

Private Sub Button1_Click(ByVal sender As System.Object,

ByVal e As System.EventArgs) Handles Button1.Click

VB

VB
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Run the project by pressing F5. The message box is displayed with both Yes and No response buttons. Click

either one.

3. 

Data Marshaling

Visual Basic automatically converts the data types of parameters and return values for Windows API calls, but you

can use the MarshalAs attribute to explicitly specify unmanaged data types that an API expects. For more

information about interop marshaling, see Interop Marshaling.

To use Declare and MarshalAs in an API call

Determine the name of the function you want to call, plus its arguments, data types, and return value.1. 

To simplify access to the MarshalAs attribute, add an Imports statement to the top of the code for the class

or module, as in the following example:

2. 

Add a function prototype for the imported function to the class or module you are using, and apply the

MarshalAs attribute to the parameters or return value. In the following example, an API call that expects the

type void* is marshaled as AsAny:

3. 

' Stores the return value.

Dim RetVal As Integer

    RetVal = MBox(0, "Declare DLL Test", "Windows API MessageBox",

        MB_ICONQUESTION Or MB_YESNO)

' Check the return value.

If RetVal = IDYES Then

        MsgBox("You chose Yes")

Else

        MsgBox("You chose No")

End If

End Sub

Imports System.Runtime.InteropServices

Declare Sub SetData Lib "..\LIB\UnmgdLib.dll" (

ByVal x As Short,

    <MarshalAsAttribute(UnmanagedType.AsAny)>

ByVal o As Object)

VB

VB
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API Calls Using DllImport
The DllImport attribute provides a second way to call functions in DLLs without type libraries. DllImport is roughly

equivalent to using a Declare statement but provides more control over how functions are called.

You can use DllImport with most Windows API calls as long as the call refers to a shared (sometimes called static)

method. You cannot use methods that require an instance of a class. Unlike Declare statements, DllImport calls cannot

use the MarshalAs attribute.

To call a Windows API using the DllImport attribute

Open a new Windows Application project by clicking New on the File menu, and then clicking Project. The New

Project dialog box appears.

1. 

Select Windows Application from the list of Visual Basic project templates. The new project is displayed.2. 

Add a button named Button2 to the startup form.3. 

Double-click Button2 to open the code view for the form.4. 

To simplify access to DllImport, add an Imports statement to the top of the code for the startup form class:5. 

Declare an empty function preceding the End Class statement for the form, and name the function MoveFile.6. 

Apply the Public and Shared modifiers to the function declaration and set parameters for MoveFile based on the

arguments the Windows API function uses:

Your function can have any valid procedure name; the DllImport attribute specifies the name in the DLL. It also

handles interoperability marshaling for the parameters and return values, so you can choose Visual Studio data

types that are similar to the data types the API uses.

7. 

Apply the DllImport attribute to the empty function. The first parameter is the name and location of the DLL

containing the function you are calling. You do not need to specify the path for files located in the Windows

system directories. The second parameter is a named argument that specifies the name of the function in the

Windows API. In this example, the DllImport attribute forces calls to MoveFile to be forwarded to MoveFileW in

KERNEL32.DLL. The MoveFileW method copies a file from the path src to the path dst.

8. 

Imports System.Runtime.InteropServices

Public Shared Function MoveFile(

ByVal src As String,

ByVal dst As String) As Boolean

' Leave the body of the function empty.

End Function

VB

VB

VB
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Add code to the Button2_Click event handler to call the function:9. 

Create a file named Test.txt and place it in the C:\Tmp directory on your hard drive. Create the Tmp directory if

necessary.

10. 

Press F5 to start the application. The main form appears.11. 

Click Button2. The message "The file was moved successfully" is displayed if the file can be moved.12. 

See Also
DllImportAttribute

MarshalAsAttribute

Declare Statement

Auto (Visual Basic)

Alias Clause (Visual Basic)

COM Interop (Visual Basic)

Creating Prototypes in Managed Code

Marshaling a Delegate as a Callback Method

© 2016 Microsoft

<DllImport("KERNEL32.DLL", EntryPoint:="MoveFileW", SetLastError:=True,

    CharSet:=CharSet.Unicode, ExactSpelling:=True,

    CallingConvention:=CallingConvention.StdCall)>

Public Shared Function MoveFile(

ByVal src As String,

ByVal dst As String) As Boolean

' Leave the body of the function empty.

End Function

Private Sub Button2_Click(ByVal sender As System.Object,

ByVal e As System.EventArgs) Handles Button2.Click

Dim RetVal As Boolean = MoveFile("c:\tmp\Test.txt", "c:\Test.txt")

If RetVal = True Then

        MsgBox("The file was moved successfully.")

Else

        MsgBox("The file could not be moved.")

End If

End Sub
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Walkthrough: Creating COM Objects with
Visual Basic

 

When creating new applications or components, it is best to create .NET Framework assemblies. However, Visual Basic also

makes it easy to expose a .NET Framework component to COM. This enables you to provide new components for earlier

application suites that require COM components. This walkthrough demonstrates how to use Visual Basic to expose .NET

Framework objects as COM objects, both with and without the COM class template.

The easiest way to expose COM objects is by using the COM class template. The COM class template creates a new class, and

then configures your project to generate the class and interoperability layer as a COM object and register it with the

operating system.

Note

Although you can also expose a class created in Visual Basic as a COM object for unmanaged code to use, it is not a true

COM object and cannot be used by Visual Basic. For more information, see COM Interoperability in .NET Framework

Applications (Visual Basic).

Note

Your computer might show different names or locations for some of the Visual Studio user interface elements in the

following instructions. The Visual Studio edition that you have and the settings that you use determine these elements.

For more information, see Personalizing the Visual Studio IDE.

To create a COM object by using the COM class template

Open a new Windows Application project from the File menu by clicking New Project.1. 

In the New Project dialog box under the Project Types field, check that Windows is selected. Select Class Library

from the Templates list, and then click OK. The new project is displayed.

2. 

Select Add New Item from the Project menu. The Add New Item dialog box is displayed.3. 

Select COM Class from the Templates list, and then click Add. Visual Basic adds a new class and configures the new

project for COM interop.

4. 

Add code such as properties, methods, and events to the COM class.5. 

Select Build ClassLibrary1 from the Build menu. Visual Basic builds the assembly and registers the COM object with

the operating system.

6. 

Visual Studio 2015
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Creating COM Objects without the COM Class Template
You can also create a COM class manually instead of using the COM class template. This procedure is helpful when you are

working from the command line or when you want more control over how COM objects are defined.

To set up your project to generate a COM object

Open a new Windows Application project from the File menu by clicking New Project.1. 

In the New Project dialog box under the Project Types field, check that Windows is selected. Select Class Library

from the Templates list, and then click OK. The new project is displayed.

2. 

In Solution Explorer, right-click your project, and then click Properties. The Project Designer is displayed.3. 

Click the Compile tab.4. 

Select the Register for COM Interop check box.5. 

To set up the code in your class to create a COM object

In Solution Explorer, double-click Class1.vb to display its code.1. 

Rename the class to ComClass1.2. 

Add the following constants to ComClass1. They will store the Globally Unique Identifier (GUID) constants that the

COM objects are required to have.

3. 

On the Tools menu, click Create Guid. In the Create GUID dialog box, click Registry Format and then click Copy.

Click Exit.

4. 

Replace the empty string for the ClassId with the GUID, removing the leading and trailing braces. For example, if

the GUID provided by Guidgen is "{2C8B0AEE‐02C9‐486e‐B809‐C780A11530FE}" then your code should

appear as follows.

5. 

Repeat the previous steps for the InterfaceId and EventsId constants, as in the following example.6. 

Public Const ClassId As String = ""

Public Const InterfaceId As String = ""

Public Const EventsId As String = ""

Public Const ClassId As String = "2C8B0AEE‐02C9‐486e‐B809‐C780A11530FE"

VB

VB

VB
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Note

Make sure that the GUIDs are new and unique; otherwise, your COM component could conflict with other COM

components.

Add the ComClass attribute to ComClass1, specifying the GUIDs for the Class ID, Interface ID, and Events ID as in

the following example:

7. 

COM classes must have a parameterless Public Sub New() constructor, or the class will not register correctly.

Add a parameterless constructor to the class:

8. 

Add properties, methods, and events to the class, ending it with an End Class statement. Select Build Solution

from the Build menu. Visual Basic builds the assembly and registers the COM object with the operating system.

Note

The COM objects you generate with Visual Basic cannot be used by other Visual Basic applications because they

are not true COM objects. Attempts to add references to such COM objects will raise an error. For details, see

COM Interoperability in .NET Framework Applications (Visual Basic).

9. 

See Also
ComClassAttribute

COM Interop (Visual Basic)

Walkthrough: Implementing Inheritance with COM Objects (Visual Basic)

#Region Directive

COM Interoperability in .NET Framework Applications (Visual Basic)

Troubleshooting Interoperability (Visual Basic)

Public Const InterfaceId As String = "3D8B5BA4‐FB8C‐5ff8‐8468‐11BF6BD5CF91"

Public Const EventsId As String = "2B691787‐6ED7‐401e‐90A4‐B3B9C0360E31"

<ComClass(ComClass1.ClassId, ComClass1.InterfaceId, ComClass1.EventsId)>

Public Class ComClass1

Public Sub New()

MyBase.New()

End Sub

VB

VB
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COM Interoperability in .NET Framework
Applications (Visual Basic)

 

When you want to use COM objects and .NET Framework objects in the same application, you need to address the

differences in how the objects exist in memory. A .NET Framework object is located in managed memory—the memory

controlled by the common language runtime—and may be moved by the runtime as needed. A COM object is located in

unmanaged memory and is not expected to move to another memory location. Visual Studio and the .NET Framework

provide tools to control the interaction of these managed and unmanaged components. For more information about

managed code, see Common Language Runtime (CLR).

In addition to using COM objects in .NET applications, you may also want to use Visual Basic to develop objects accessible

from unmanaged code through COM.

The links on this page provide details on the interactions between COM and .NET Framework objects.

Related Sections

COM Interop (Visual Basic)

Provides links to topics covering COM interoperability in Visual Basic, including COM objects, ActiveX controls,

Win32 DLLs, managed objects, and inheritance of COM objects.

COM Interop Wrapper Error

Describes the consequences and options if the project system cannot create a COM interoperability wrapper for a

particular component.

Interoperating with Unmanaged Code

Briefly describes some of the interaction issues between managed and unmanaged code, and provides links for

further study.

COM Wrappers

Discusses runtime callable wrappers, which allow managed code to call COM methods, and COM callable wrappers,

which allow COM clients to call .NET object methods.

Advanced COM Interoperability

Provides links to topics covering COM interoperability with respect to wrappers, exceptions, inheritance, threading,

events, conversions, and marshaling.

Tlbimp.exe (Type Library Importer)

Discusses the tool you can use to convert the type definitions found within a COM type library into equivalent

definitions in a common language runtime assembly.

© 2016 Microsoft
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Interoperating with Unmanaged Code

 

The .NET Framework promotes interaction with COM components, COM+ services, external type libraries, and many

operating system services. Data types, method signatures, and error-handling mechanisms vary between managed and

unmanaged object models. To simplify interoperation between .NET Framework components and unmanaged code and to

ease the migration path, the common language runtime conceals from both clients and servers the differences in these

object models.

Code that executes under the control of the runtime is called managed code. Conversely, code that runs outside the runtime

is called unmanaged code. COM components, ActiveX interfaces, and Win32 API functions are examples of unmanaged

code.

In This Section

Interoperating with Unmanaged Code How-to Topics

Provides links to all How-to topics found in the conceptual documentation for interoperating with unmanaged code.

Exposing COM Components to the .NET Framework

Describes how to use COM components from .NET Framework applications.

Exposing .NET Framework Components to COM

Describes how to use .NET Framework components from COM applications.

Consuming Unmanaged DLL Functions

Describes how to call unmanaged DLL functions using platform invoke.

Design Considerations for Interoperation

Provides tips for writing integrated COM components.

Interop Marshaling

Describes marshaling for COM interop and platform invoke.

How to: Map HRESULTs and Exceptions

Describes the mapping between exceptions and HRESULTs.

Interoperating Using Generic Types

Describes the behavior of generic types when used in COM interop.

Related Sections

Advanced COM Interoperability

Provides links to more information about incorporating COM components into your .NET Framework application.

© 2016 Microsoft
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Working with Application Logs in Visual
Basic

 

The My.Applicaton.Log and My.Log objects make it easy to write logging and tracing information to logs.

How Messages are Logged
First, the severity of the message is checked with the Switch property of the log's TraceSource property. By default, only

messages of severity "Information" and higher are passed on to the trace listeners, specified in the log's TraceListener

collection. Then, each listener compares the severity of the message to the listener's Switch property. If the message's

severity is high enough, the listener writes out the message.

The following diagram shows how a message written to the WriteEntry method gets passed to the WriteLine methods

of the log's trace listeners:

You can change the behavior of the log and the trace listeners by changing the application's configuration file. The

following diagram shows the correspondence between the parts of the log and the configuration file.

Visual Studio 2015

Working with Application Logs in Visual Basic https://msdn.microsoft.com/en-us/library/3tbf1bh0(d=printer)

1 of 4 03.09.2016 23:40



Where Messages are Logged
If the assembly has no configuration file, the My.Application.Log and My.Log objects write to the application's debug

output (through the DefaultTraceListener class). In addition, the My.Application.Log object writes to the assembly's log

file (through the FileLogTraceListener class), while the My.Log object writes to the ASP.NET Web page's output (through

the WebPageTraceListener class).

The debug output can be viewed in the Visual Studio Output window when running your application in debug mode. To

open the Output window, click the Debug menu item, point to Windows, and then click Output. In the Output window,

select Debug from the Show output from box.

By default, My.Application.Log writes the log file in the path for the user's application data. You can get the path from

the FullLogFileName property of the DefaultFileLogWriter object. The format of that path is as follows:

BasePath\CompanyName\ProductName\ProductVersion

A typical value for BasePath is as follows.

C:\Documents and Settings\username\Application Data

The values of CompanyName, ProductName, and ProductVersion come from the application's assembly information. The

form of the log file name is AssemblyName.log, where AssemblyName is the file name of the assembly without the

extension. If more than one log file is needed, such as when the original log is unavailable when the application attempts

to write to the log, the form for the log file name is AssemblyName-iteration.log, where iteration is a positive Integer.

You can override the default behavior by adding or changing the computer's and the application's configuration files. For

more information, see Walkthrough: Changing Where My.Application.Log Writes Information (Visual Basic).

Configuring Log Settings
The Log object has a default implementation that works without an application configuration file, app.config. To change

the defaults, you must add a configuration file with the new settings. For more information, see Walkthrough: Filtering

My.Application.Log Output (Visual Basic).

The log configuration sections are located in the <system.diagnostics> node in the main <configuration> node of
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the app.config file. Log information is defined in several nodes:

The listeners for the Log object are defined in the <sources> node named DefaultSource.

The severity filter for the Log object is defined in the <switches> node named DefaultSwitch.

The log listeners are defined in the <sharedListeners> node.

Examples of <sources>, <switches>, and <sharedListeners> nodes are shown in the following code:

Changing Log Settings after Deployment

<configuration>

  <system.diagnostics>

    <sources>

      <source name="DefaultSource" switchName="DefaultSwitch">

        <listeners>

          <add name="FileLog"/>

        </listeners>

      </source>

    </sources>

    <switches>

      <add name="DefaultSwitch" value="Information" />

    </switches>

    <sharedListeners>

      <add name="FileLog"

        type="Microsoft.VisualBasic.Logging.FileLogTraceListener,

          Microsoft.VisualBasic, Version=8.0.0.0, Culture=neutral, 

          PublicKeyToken=b03f5f7f11d50a3a, processorArchitecture=MSIL"

        initializeData="FileLogWriter"

      />

    </sharedListeners>

  </system.diagnostics>

</configuration>
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When you develop an application, its configuration settings are stored in the app.config file, as shown in the examples

above. After you deploy your application, you can still configure the log by editing the configuration file. In a

Windows-based application, this file's name is applicationName.exe.config, and it must reside in the same folder as the

executable file. For a Web application, this is the Web.config file associated with the project.

When your application executes the code that creates an instance of a class for the first time, it checks the configuration

file for information about the object. For the Log object, this happens the first time the Log object is accessed. The system

examines the configuration file only once for any particular object—the first time your application creates the object.

Therefore, you may need to restart the application for the changes to take effect.

In a deployed application, you enable trace code by reconfiguring switch objects before your application starts. Typically,

this involves turning the switch objects on and off or by changing the tracing levels, and then restarting your application.

Security Considerations
Consider the following when writing data to the log:

Avoid leaking user information. Ensure that your application writes only approved information to the log. For

example, it may be acceptable for the application log to contain user names, but not user passwords.

Make log locations secure. Any log that contains potentially sensitive information should be stored in a secure

location.

Avoid misleading information. In general, your application should validate all data entered by a user before

using that data. This includes writing data to the application log.

Avoid denial of service. If your application writes too much information to the log, it could fill the log or make

finding important information difficult.

See Also
Microsoft.VisualBasic.Logging.Log

Logging Information from the Application (Visual Basic)

© 2016 Microsoft
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Walkthrough: Creating Custom Log Listeners
(Visual Basic)

 

This walkthrough demonstrates how to create a custom log listener and configure it to listen to the output of the

My.Application.Log object.

Getting Started
Log listeners must inherit from the TraceListener class.

To create the listener

In your application, create a class named SimpleListener that inherits from TraceListener.

The Write and WriteLine methods, required by the base class, call MsgBox to display their input.

The HostProtectionAttribute attribute is applied to the Write and WriteLine methods so that their attributes match

the base class methods. The HostProtectionAttribute attribute allows the host that runs the code to determine that

the code exposes host-protection synchronization.

Note

The HostProtectionAttribute attribute is effective only on unmanaged applications that host the common

language runtime and that implement host protection, such as SQL Server.

To ensure that My.Application.Log uses your log listener, you should strongly name the assembly that contains your log

Visual Studio 2015

Public Class SimpleListener

Inherits System.Diagnostics.TraceListener

    <Security.Permissions.HostProtection(Synchronization:=True)> 

Public Overloads Overrides Sub Write(ByVal message As String)

        MsgBox("Write: " & message)

End Sub

    <Security.Permissions.HostProtection(Synchronization:=True)> 

Public Overloads Overrides Sub WriteLine(ByVal message As String)

        MsgBox("WriteLine: " & message)

End Sub

End Class

VB

Walkthrough: Creating Custom Log Listeners (Visual Basic) https://msdn.microsoft.com/en-us/library/ms172718(d=printer)

1 of 3 03.09.2016 23:42



listener.

The next procedure provides some simple steps for creating a strongly named log-listener assembly. For more

information, see Creating and Using Strong-Named Assemblies.

To strongly name the log-listener assembly

Have a project selected in Solution Explorer. On the Project menu, choose Properties. For more information, see

Introduction to the Project Designer.

1. 

Click the Signing tab.2. 

Select the Sign the assembly box.3. 

Select <New> from the Choose a strong name key file drop-down list.

The Create Strong Name Key dialog box opens.

4. 

Provide a name for the key file in the Key file name box.5. 

Enter a password in the Enter password and Confirm password boxes.6. 

Click OK.7. 

Rebuild the application.8. 

Adding the Listener
Now that the assembly has a strong name, you need to determine the strong name of the listener so that

My.Application.Log uses your log listener.

The format of a strongly named type is as follows.

<type name>, <assembly name>, <version number>, <culture>, <strong name>

To determine the strong name of the listener

The following code shows how to determine the strongly named type name for SimpleListener.

The strong name of the type depends on your project.

With the strong name, you can add the listener to the My.Application.Log log-listener collection.

Public Sub DisplaySimpleListenerStrongName()

Dim t As Type = GetType(SimpleListener)

    MsgBox(t.FullName & ", " & t.Assembly.FullName)

End Sub

VB
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To add the listener to My.Application.Log

Right-click on app.config in the Solution Explorer and choose Open.

-or-

If there is an app.config file:

On the Project menu, choose Add New Item.a. 

From the Add New Item dialog box, choose Application Configuration File.b. 

Click Add.c. 

1. 

Locate the <listeners> section, in the <source> section with the name attribute "DefaultSource", located in the

<sources> section. The <sources> section is located in the <system.diagnostics> section, in the top-level

<configuration> section.

2. 

Add this element to the <listeners> section:3. 

Locate the <sharedListeners> section, in the <system.diagnostics> section, in the top-level

<configuration> section.

4. 

Add this element to that <sharedListeners> section:

Change the value of SimpleLogStrongName to be the strong name of the listener.

5. 

See Also
Microsoft.VisualBasic.Logging.Log

Working with Application Logs in Visual Basic

How to: Log Exceptions in Visual Basic

How to: Write Log Messages (Visual Basic)

Walkthrough: Changing Where My.Application.Log Writes Information (Visual Basic)

© 2016 Microsoft
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Walkthrough: Embedding Types from
Managed Assemblies in Visual Studio (Visual
Basic)

 

If you embed type information from a strong-named managed assembly, you can loosely couple types in an application to

achieve version independence. That is, your program can be written to use types from multiple versions of a managed

library without having to be recompiled for each version.

Type embedding is frequently used with COM interop, such as an application that uses automation objects from Microsoft

Office. Embedding type information enables the same build of a program to work with different versions of Microsoft Office

on different computers. However, you can also use type embedding with a fully managed solution.

Type information can be embedded from an assembly that has the following characteristics:

The assembly exposes at least one public interface.

The embedded interfaces are annotated with a ComImport attribute and a Guid attribute (and a unique GUID).

The assembly is annotated with the ImportedFromTypeLib attribute or the PrimaryInteropAssembly attribute, and

an assembly-level Guid attribute. (By default, Visual Basic project templates include an assembly-level Guid attribute.)

After you have specified the public interfaces that can be embedded, you can create runtime classes that implement those

interfaces. A client program can then embed the type information for those interfaces at design time by referencing the

assembly that contains the public interfaces and setting the Embed Interop Types property of the reference to True. This is

equivalent to using the command line compiler and referencing the assembly by using the /link compiler option. The client

program can then load instances of your runtime objects typed as those interfaces. If you create a new version of your

strong-named runtime assembly, the client program does not have to be recompiled with the updated runtime assembly.

Instead, the client program continues to use whichever version of the runtime assembly is available to it, using the

embedded type information for the public interfaces.

Because the primary function of type embedding is to support embedding of type information from COM interop

assemblies, the following limitations apply when you embed type information in a fully managed solution:

Only attributes specific to COM interop are embedded; other attributes are ignored.

If a type uses generic parameters and the type of the generic parameter is an embedded type, that type cannot be

used across an assembly boundary. Examples of crossing an assembly boundary include calling a method from

another assembly or a deriving a type from a type defined in another assembly.

Constants are not embedded.

The System.Collections.Generic.Dictionary(Of TKey, TValue) class does not support an embedded type as a key. You

can implement your own dictionary type to support an embedded type as a key.
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In this walkthrough, you will do the following:

Create a strong-named assembly that has a public interface that contains type information that can be embedded.

Create a strong-named runtime assembly that implements that public interface.

Create a client program that embeds the type information from the public interface and creates an instance of the

class from the runtime assembly.

Modify and rebuild the runtime assembly.

Run the client program to see that the new version of the runtime assembly is being used without having to

recompile the client program.

Note

Your computer might show different names or locations for some of the Visual Studio user interface elements in the

following instructions. The Visual Studio edition that you have and the settings that you use determine these elements.

For more information, see Personalizing the Visual Studio IDE.

Creating an Interface

To create the type equivalence interface project

In Visual Studio, on the File menu, point to New and then click Project.1. 

In the New Project dialog box, in the Project Types pane, make sure that Windows is selected. Select Class

Library in the Templates pane. In the Name box, type TypeEquivalenceInterface, and then click OK. The new

project is created.

2. 

In Solution Explorer, right-click the Class1.vb file and click Rename. Rename the file to ISampleInterface.vb and

press ENTER. Renaming the file will also rename the class to ISampleInterface. This class will represent the public

interface for the class.

3. 

Right-click the TypeEquivalenceInterface project and click Properties. Click the Compile tab. Set the output path

to a valid location on your development computer, such as C:\TypeEquivalenceSample. This location will also be

used in a later step in this walkthrough. 

4. 

While still editing the project properties, click the Signing tab. Select the Sign the assembly option. In the

Choose a strong name key file list, click <New...>. In the Key file name box, type key.snk. Clear the Protect

my key file with a password check box. Click OK.

5. 

Open the ISampleInterface.vb file. Add the following code to the ISampleInterface class file to create the

ISampleInterface interface.

6. 

Imports System.Runtime.InteropServices

<ComImport()>
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On the Tools menu, click Create Guid. In the Create GUID dialog box, click Registry Format and then click Copy.

Click Exit.

7. 

In the Guid attribute, delete the sample GUID and paste in the GUID that you copied from the Create GUID dialog

box. Remove the braces ({}) from the copied GUID.

8. 

On the Project menu, click Show All Files.9. 

In Solution Explorer, expand the My Project folder. Double-click the AssemblyInfo.vb. Add the following

attribute to the file.

Save the file.

10. 

Save the project.11. 

Right-click the TypeEquivalenceInterface project and click Build. The class library .dll file is compiled and saved to

the specified build output path (for example, C:\TypeEquivalenceSample).

12. 

Creating a Runtime Class

To create the type equivalence runtime project

In Visual Studio, on the File menu, point to New and then click Project.1. 

In the New Project dialog box, in the Project Types pane, make sure that Windows is selected. Select Class

Library in the Templates pane. In the Name box, type TypeEquivalenceRuntime, and then click OK. The new

project is created.

2. 

In Solution Explorer, right-click the Class1.vb file and click Rename. Rename the file to SampleClass.vb and press

ENTER. Renaming the file also renames the class to SampleClass. This class will implement the

ISampleInterface interface.

3. 

Right-click the TypeEquivalenceRuntime project and click Properties. Click the Compile tab. Set the output path

to the same location you used in the TypeEquivalenceInterface project, for example, C:\TypeEquivalenceSample.

4. 

While still editing the project properties, click the Signing tab. Select the Sign the assembly option. In the

Choose a strong name key file list, click <New...>. In the Key file name box, type key.snk. Clear the Protect

my key file with a password check box. Click OK.

5. 

Right-click the TypeEquivalenceRuntime project and click Add Reference. Click the Browse tab and browse to the6. 

<Guid("8DA56996‐A151‐4136‐B474‐32784559F6DF")>

Public Interface ISampleInterface

Sub GetUserInput()

ReadOnly Property UserInput As String

End Interface

<Assembly: ImportedFromTypeLib("")>

VB

Walkthrough: Embedding Types from Managed Assemblies in Visual Stud... https://msdn.microsoft.com/en-us/library/mt631699(d=printer)

3 of 6 03.09.2016 23:44



output path folder. Select the TypeEquivalenceInterface.dll file and click OK.

On the Project menu, click Show All Files.7. 

In Solution Explorer, expand the References folder. Select the TypeEquivalenceInterface reference. In the

Properties window for the TypeEquivalenceInterface reference, set the Specific Version property to False.

8. 

Add the following code to the SampleClass class file to create the SampleClass class.9. 

Save the project.10. 

Right-click the TypeEquivalenceRuntime project and click Build. The class library .dll file is compiled and saved to

the specified build output path (for example, C:\TypeEquivalenceSample).

11. 

Creating a Client Project

To create the type equivalence client project

In Visual Studio, on the File menu, point to New and then click Project.1. 

In the New Project dialog box, in the Project Types pane, make sure that Windows is selected. Select Console

Application in the Templates pane. In the Name box, type TypeEquivalenceClient, and then click OK. The new

project is created.

2. 

Right-click the TypeEquivalenceClient project and click Properties. Click the Compile tab. Set the output path to

the same location you used in the TypeEquivalenceInterface project, for example, C:\TypeEquivalenceSample.

3. 

Right-click the TypeEquivalenceClient project and click Add Reference. Click the Browse tab and browse to the

output path folder. Select the TypeEquivalenceInterface.dll file (not the TypeEquivalenceRuntime.dll) and click OK.

4. 

Imports TypeEquivalenceInterface

Public Class SampleClass

Implements ISampleInterface

Private p_UserInput As String

Public ReadOnly Property UserInput() As String Implements

ISampleInterface.UserInput

Get

Return p_UserInput

End Get

End Property

Public Sub GetUserInput() Implements ISampleInterface.GetUserInput

        Console.WriteLine("Please enter a value:")

        p_UserInput = Console.ReadLine()

End Sub

End Class
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On the Project menu, click Show All Files.5. 

In Solution Explorer, expand the References folder. Select the TypeEquivalenceInterface reference. In the

Properties window for the TypeEquivalenceInterface reference, set the Embed Interop Types property to True.

6. 

Add the following code to the Module1.vb file to create the client program.7. 

Press CTRL+F5 to build and run the program.8. 

Modifying the Interface

To modify the interface

In Visual Studio, on the File menu, point to Open, and then click Project/Solution.1. 

In the Open Project dialog box, right-click the TypeEquivalenceInterface project, and then click Properties. Click

the Application tab. Click the Assembly Information button. Change the Assembly Version and File Version

values to 2.0.0.0.

2. 

Open the ISampleInterface.vb file. Add the following line of code to the ISampleInterface interface.

Save the file.

3. 

Save the project.4. 

Right-click the TypeEquivalenceInterface project and click Build. A new version of the class library .dll file is5. 

Imports TypeEquivalenceInterface

Imports System.Reflection

Module Module1

Sub Main()

Dim sampleAssembly = Assembly.Load("TypeEquivalenceRuntime")

Dim sampleClass As ISampleInterface = CType( _

            sampleAssembly.CreateInstance("TypeEquivalenceRuntime.SampleClass"), 

ISampleInterface)

        sampleClass.GetUserInput()

        Console.WriteLine(sampleClass.UserInput)

        Console.WriteLine(sampleAssembly.GetName().Version)

        Console.ReadLine()

End Sub

End Module

Function GetDate() As Date
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compiled and saved in the specified build output path (for example, C:\TypeEquivalenceSample).

Modifying the Runtime Class

To modify the runtime class

In Visual Studio, on the File menu, point to Open, and then click Project/Solution.1. 

In the Open Project dialog box, right-click the TypeEquivalenceRuntime project and click Properties. Click the

Application tab. Click the Assembly Information button. Change the Assembly Version and File Version values

to 2.0.0.0.

2. 

Open the SampleClass.vbfile. Add the following lines of code to the SampleClass class.

Save the file.

3. 

Save the project.4. 

Right-click the TypeEquivalenceRuntime project and click Build. An updated version of the class library .dll file is

compiled and saved in the previously specified build output path (for example, C:\TypeEquivalenceSample).

5. 

In File Explorer, open the output path folder (for example, C:\TypeEquivalenceSample). Double-click the

TypeEquivalenceClient.exe to run the program. The program will reflect the new version of the

TypeEquivalenceRuntime assembly without having been recompiled.

6. 

See Also
/link (Visual Basic)

Visual Basic Programming Guide

Programming with Assemblies

Assemblies and the Global Assembly Cache (Visual Basic)

© 2016 Microsoft

Public Function GetDate() As DateTime Implements ISampleInterface.GetDate

Return Now

End Function
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How to: Share an Assembly with Other
Applications (Visual Basic)

 

Assemblies can be private or shared: by default, most simple programs consist of a private assembly because they are not

intended to be used by other applications.

In order to share an assembly with other applications, it must be placed in the Global Assembly Cache (GAC).

Sharing an assembly

Create your assembly. For more information, see Creating Assemblies.1. 

Assign a strong name to your assembly. For more information, see How to: Sign an Assembly with a Strong Name.2. 

Assign version information to your assembly. For more information, see Assembly Versioning.3. 

Add your assembly to the Global Assembly Cache. For more information, see How to: Install an Assembly into the

Global Assembly Cache.

4. 

Access the types contained in the assembly from the other applications. For more information, see How to: Reference

a Strong-Named Assembly.

5. 

See Also
Visual Basic Programming Guide

Programming with Assemblies

© 2016 Microsoft
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Walkthrough: Manipulating Files and
Directories in Visual Basic

 

This walkthrough provides an introduction to the fundamentals of file I/O in Visual Basic. It describes how to create a small

application that lists and examines text files in a directory. For each selected text file, the application provides file attributes

and the first line of content. There is an option to write information to a log file.

This walkthrough uses members of the My.Computer.FileSystem Object, which are available in Visual Basic. See FileSystem

for more information. At the end of the walkthrough, an equivalent example is provided that uses classes from the System.IO

namespace.

Note

Your computer might show different names or locations for some of the Visual Studio user interface elements in the

following instructions. The Visual Studio edition that you have and the settings that you use determine these elements.

For more information, see Personalizing the Visual Studio IDE.

To create the project

On the File menu, click New Project.

The New Project dialog box appears.

1. 

In the Installed Templates pane, expand Visual Basic, and then click Windows. In the Templates pane in the

middle, click Windows Forms Application.

2. 

In the Name box, type FileExplorer to set the project name, and then click OK.

Visual Studio adds the project to Solution Explorer, and the Windows Forms Designer opens.

3. 

Add the controls in the following table to the form, and set the corresponding values for their properties.

Control Property Value

ListBox Name filesListBox

Button Name

Text

browseButton

Browse

4. 
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Button Name

Text

examineButton

Examine

CheckBox Name

Text

saveCheckBox

Save Results

FolderBrowserDialog Name FolderBrowserDialog1

To select a folder, and list files in a folder

Create a Click event handler for browseButton by double-clicking the control on the form. The Code Editor opens.1. 

Add the following code to the Click event handler.

The FolderBrowserDialog1.ShowDialog call opens the Browse For Folder dialog box. After the user clicks OK,

the SelectedPath property is sent as an argument to the ListFiles method, which is added in the next step.

2. 

Add the following ListFiles method.

This code first clears the ListBox.

The GetFiles method then retrieves a collection of strings, one for each file in the directory. The GetFiles method

accepts a search pattern argument to retrieve files that match a particular pattern. In this example, only files that have

the extension .txt are returned.

The strings that are returned by the GetFiles method are then added to the ListBox.

3. 

Run the application. Click the Browse button. In the Browse For Folder dialog box, browse to a folder that contains4. 

If FolderBrowserDialog1.ShowDialog() = DialogResult.OK Then

' List files in the folder.

    ListFiles(FolderBrowserDialog1.SelectedPath)

End If

Private Sub ListFiles(ByVal folderPath As String)

    filesListBox.Items.Clear()

Dim fileNames = My.Computer.FileSystem.GetFiles(

        folderPath, FileIO.SearchOption.SearchTopLevelOnly, "*.txt")

For Each fileName As String In fileNames

        filesListBox.Items.Add(fileName)

Next

End Sub
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.txt files, and then select the folder and click OK.

The ListBox contains a list of .txt files in the selected folder.

Stop running the application.5. 

To obtain attributes of a file, and content from a text file

Create a Click event handler for examineButton by double-clicking the control on the form.1. 

Add the following code to the Click event handler.

The code verifies that an item is selected in the ListBox. It then obtains the file path entry from the ListBox. The

FileExists method is used to check whether the file still exists.

The file path is sent as an argument to the GetTextForOutput method, which is added in the next step. This method

returns a string that contains file information. The file information appears in a MessageBox.

2. 

Add the following GetTextForOutput method.3. 

If filesListBox.SelectedItem Is Nothing Then

    MessageBox.Show("Please select a file.")

Exit Sub

End If

' Obtain the file path from the list box selection.

Dim filePath = filesListBox.SelectedItem.ToString

' Verify that the file was not removed since the

' Browse button was clicked.

If My.Computer.FileSystem.FileExists(filePath) = False Then

    MessageBox.Show("File Not Found: " & filePath)

Exit Sub

End If

' Obtain file information in a string.

Dim fileInfoText As String = GetTextForOutput(filePath)

' Show the file information.

MessageBox.Show(fileInfoText)

Private Function GetTextForOutput(ByVal filePath As String) As String

' Verify that the file exists.

If My.Computer.FileSystem.FileExists(filePath) = False Then

Throw New Exception("File Not Found: " & filePath)

End If

' Create a new StringBuilder, which is used

VB
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The code uses the GetFileInfo method to obtain file parameters. The file parameters are added to a StringBuilder.

The OpenTextFileReader method reads the file contents into a StreamReader. The first line of the contents is obtained

from the StreamReader and is added to the StringBuilder.

Run the application. Click Browse, and browse to a folder that contains .txt files. Click OK.

Select a file in the ListBox, and then click Examine. A MessageBox shows the file information.

4. 

Stop running the application.5. 

To add a log entry

Add the following code to the end of the examineButton_Click event handler.1. 

' to efficiently build strings.

Dim sb As New System.Text.StringBuilder()

' Obtain file information.

Dim thisFile As System.IO.FileInfo = My.Computer.FileSystem.GetFileInfo(filePath)

' Add file attributes.

    sb.Append("File: " & thisFile.FullName)

    sb.Append(vbCrLf)

    sb.Append("Modified: " & thisFile.LastWriteTime.ToString)

    sb.Append(vbCrLf)

    sb.Append("Size: " & thisFile.Length.ToString & " bytes")

    sb.Append(vbCrLf)

' Open the text file.

Dim sr As System.IO.StreamReader =

My.Computer.FileSystem.OpenTextFileReader(filePath)

' Add the first line from the file.

If sr.Peek() >= 0 Then

        sb.Append("First Line: " & sr.ReadLine())

End If

    sr.Close()

Return sb.ToString

End Function

If saveCheckBox.Checked = True Then

' Place the log file in the same folder as the examined file.

Dim logFolder As String = 

My.Computer.FileSystem.GetFileInfo(filePath).DirectoryName

Dim logFilePath = My.Computer.FileSystem.CombinePath(logFolder, "log.txt")

Dim logText As String = "Logged: " & Date.Now.ToString &

        vbCrLf & fileInfoText & vbCrLf & vbCrLf

VB

Walkthrough: Manipulating Files and Directories in Visual Basic https://msdn.microsoft.com/en-us/library/cahdzfxw(d=printer)

4 of 11 03.09.2016 23:45



The code sets the log file path to put the log file in the same directory as that of the selected file. The text of the log

entry is set to the current date and time followed by the file information.

The WriteAllText method, with the append argument set to True, is used to create the log entry.

Run the application. Browse to a text file, select it in the ListBox, select the Save Results check box, and then click

Examine. Verify that the log entry is written to the log.txt file.

2. 

Stop running the application.3. 

To use the current directory

Create an event handler for Form1_Load by double-clicking the form.1. 

Add the following code to the event handler.

This code sets the default directory of the folder browser to the current directory.

2. 

Run the application. When you click Browse the first time, the Browse For Folder dialog box opens to the current

directory.

3. 

Stop running the application.4. 

To selectively enable controls

Add the following SetEnabled method.

The SetEnabled method enables or disables controls depending on whether an item is selected in the ListBox.

1. 

' Append text to the log file.

My.Computer.FileSystem.WriteAllText(logFilePath, logText, append:=True)

End If

' Set the default directory of the folder browser to the current directory.

FolderBrowserDialog1.SelectedPath = My.Computer.FileSystem.CurrentDirectory

Private Sub SetEnabled()

Dim anySelected As Boolean =

        (filesListBox.SelectedItem IsNot Nothing)

    examineButton.Enabled = anySelected

    saveCheckBox.Enabled = anySelected

End Sub
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Create a SelectedIndexChanged event handler for filesListBox by double-clicking the ListBox control on the

form.

2. 

Add a call to SetEnabled in the new filesListBox_SelectedIndexChanged event handler.3. 

Add a call to SetEnabled at the end of the browseButton_Click event handler.4. 

Add a call to SetEnabled at the end of the Form1_Load event handler.5. 

Run the application. The Save Results check box and the Examine button are disabled if an item is not selected in

the ListBox.

6. 

Full example using My.Computer.FileSystem
Following is the complete example.

' This example uses members of the My.Computer.FileSystem

' object, which are available in Visual Basic.

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) 

Handles MyBase.Load

' Set the default directory of the folder browser to the current directory.

    FolderBrowserDialog1.SelectedPath = My.Computer.FileSystem.CurrentDirectory

    SetEnabled()

End Sub

Private Sub browseButton_Click(ByVal sender As System.Object, ByVal e As

System.EventArgs) Handles browseButton.Click

If FolderBrowserDialog1.ShowDialog() = DialogResult.OK Then

' List files in the folder.

        ListFiles(FolderBrowserDialog1.SelectedPath)

End If

    SetEnabled()

End Sub

Private Sub ListFiles(ByVal folderPath As String)

    filesListBox.Items.Clear()

Dim fileNames = My.Computer.FileSystem.GetFiles(

        folderPath, FileIO.SearchOption.SearchTopLevelOnly, "*.txt")

For Each fileName As String In fileNames

        filesListBox.Items.Add(fileName)

Next

End Sub

Private Sub examineButton_Click(ByVal sender As System.Object, ByVal e As

System.EventArgs) Handles examineButton.Click
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If filesListBox.SelectedItem Is Nothing Then

        MessageBox.Show("Please select a file.")

Exit Sub

End If

' Obtain the file path from the list box selection.

Dim filePath = filesListBox.SelectedItem.ToString

' Verify that the file was not removed since the

' Browse button was clicked.

If My.Computer.FileSystem.FileExists(filePath) = False Then

        MessageBox.Show("File Not Found: " & filePath)

Exit Sub

End If

' Obtain file information in a string.

Dim fileInfoText As String = GetTextForOutput(filePath)

' Show the file information.

    MessageBox.Show(fileInfoText)

If saveCheckBox.Checked = True Then

' Place the log file in the same folder as the examined file.

Dim logFolder As String = 

My.Computer.FileSystem.GetFileInfo(filePath).DirectoryName

Dim logFilePath = My.Computer.FileSystem.CombinePath(logFolder, "log.txt")

Dim logText As String = "Logged: " & Date.Now.ToString &

            vbCrLf & fileInfoText & vbCrLf & vbCrLf

' Append text to the log file.

My.Computer.FileSystem.WriteAllText(logFilePath, logText, append:=True)

End If

End Sub

Private Function GetTextForOutput(ByVal filePath As String) As String

' Verify that the file exists.

If My.Computer.FileSystem.FileExists(filePath) = False Then

Throw New Exception("File Not Found: " & filePath)

End If

' Create a new StringBuilder, which is used

' to efficiently build strings.

Dim sb As New System.Text.StringBuilder()

' Obtain file information.

Dim thisFile As System.IO.FileInfo = My.Computer.FileSystem.GetFileInfo(filePath)

' Add file attributes.

    sb.Append("File: " & thisFile.FullName)

    sb.Append(vbCrLf)

    sb.Append("Modified: " & thisFile.LastWriteTime.ToString)

    sb.Append(vbCrLf)

    sb.Append("Size: " & thisFile.Length.ToString & " bytes")
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Full example using System.IO
The following equivalent example uses classes from the System.IO namespace instead of using My.Computer.FileSystem

objects.

    sb.Append(vbCrLf)

' Open the text file.

Dim sr As System.IO.StreamReader =

My.Computer.FileSystem.OpenTextFileReader(filePath)

' Add the first line from the file.

If sr.Peek() >= 0 Then

        sb.Append("First Line: " & sr.ReadLine())

End If

    sr.Close()

Return sb.ToString

End Function

Private Sub filesListBox_SelectedIndexChanged(ByVal sender As System.Object, ByVal e As

System.EventArgs) Handles filesListBox.SelectedIndexChanged

    SetEnabled()

End Sub

Private Sub SetEnabled()

Dim anySelected As Boolean =

        (filesListBox.SelectedItem IsNot Nothing)

    examineButton.Enabled = anySelected

    saveCheckBox.Enabled = anySelected

End Sub

' This example uses classes from the System.IO namespace.

Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) 

Handles MyBase.Load

' Set the default directory of the folder browser to the current directory.

    FolderBrowserDialog1.SelectedPath =

        System.IO.Directory.GetCurrentDirectory()

    SetEnabled()

End Sub

Private Sub browseButton_Click(ByVal sender As System.Object, ByVal e As

System.EventArgs) Handles browseButton.Click

If FolderBrowserDialog1.ShowDialog() = DialogResult.OK Then
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' List files in the folder.

        ListFiles(FolderBrowserDialog1.SelectedPath)

        SetEnabled()

End If

End Sub

Private Sub ListFiles(ByVal folderPath As String)

    filesListBox.Items.Clear()

Dim fileNames As String() =

        System.IO.Directory.GetFiles(folderPath,

"*.txt", System.IO.SearchOption.TopDirectoryOnly)

For Each fileName As String In fileNames

        filesListBox.Items.Add(fileName)

Next

End Sub

Private Sub examineButton_Click(ByVal sender As System.Object, ByVal e As

System.EventArgs) Handles examineButton.Click

If filesListBox.SelectedItem Is Nothing Then

        MessageBox.Show("Please select a file.")

Exit Sub

End If

' Obtain the file path from the list box selection.

Dim filePath = filesListBox.SelectedItem.ToString

' Verify that the file was not removed since the

' Browse button was clicked.

If System.IO.File.Exists(filePath) = False Then

        MessageBox.Show("File Not Found: " & filePath)

Exit Sub

End If

' Obtain file information in a string.

Dim fileInfoText As String = GetTextForOutput(filePath)

' Show the file information.

    MessageBox.Show(fileInfoText)

If saveCheckBox.Checked = True Then

' Place the log file in the same folder as the examined file.

Dim logFolder As String =

            System.IO.Path.GetDirectoryName(filePath)

Dim logFilePath = System.IO.Path.Combine(logFolder, "log.txt")

' Append text to the log file.

Dim logText As String = "Logged: " & Date.Now.ToString &

            vbCrLf & fileInfoText & vbCrLf & vbCrLf

        System.IO.File.AppendAllText(logFilePath, logText)

End If

End Sub
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See Also
System.IO

Private Function GetTextForOutput(ByVal filePath As String) As String

' Verify that the file exists.

If System.IO.File.Exists(filePath) = False Then

Throw New Exception("File Not Found: " & filePath)

End If

' Create a new StringBuilder, which is used

' to efficiently build strings.

Dim sb As New System.Text.StringBuilder()

' Obtain file information.

Dim thisFile As New System.IO.FileInfo(filePath)

' Add file attributes.

    sb.Append("File: " & thisFile.FullName)

    sb.Append(vbCrLf)

    sb.Append("Modified: " & thisFile.LastWriteTime.ToString)

    sb.Append(vbCrLf)

    sb.Append("Size: " & thisFile.Length.ToString & " bytes")

    sb.Append(vbCrLf)

' Open the text file.

Dim sr As System.IO.StreamReader =

        System.IO.File.OpenText(filePath)

' Add the first line from the file.

If sr.Peek() >= 0 Then

        sb.Append("First Line: " & sr.ReadLine())

End If

    sr.Close()

Return sb.ToString

End Function

Private Sub filesListBox_SelectedIndexChanged(ByVal sender As System.Object, ByVal e As

System.EventArgs) Handles filesListBox.SelectedIndexChanged

    SetEnabled()

End Sub

Private Sub SetEnabled()

Dim anySelected As Boolean =

        (filesListBox.SelectedItem IsNot Nothing)

    examineButton.Enabled = anySelected

    saveCheckBox.Enabled = anySelected

End Sub
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FileSystem

CurrentDirectory
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Basics of .NET Framework File I/O and the
File System (Visual Basic)

 

Classes in the System.IO namespace are used to work with drives, files, and directories.

The System.IO namespace contains the File and Directory classes, which provide the .NET Framework functionality that

manipulates files and directories. Because the methods of these objects are static or shared members, you can use them

directly without creating an instance of the class first. Associated with these classes are the FileInfo and DirectoryInfo classes,

which will be familiar to users of the My feature. To use these classes, you must fully qualify the names or import the

appropriate namespaces by including the Imports statement(s) at the beginning of the affected code. For more information,

see Imports Statement (.NET Namespace and Type).

Note

Other topics in this section use the My.Computer.FileSystem object instead of System.IO classes to work with drives,

files, and directories. The My.Computer.FileSystem object is intended primarily for use in Visual Basic programs.

System.IO classes are intended for use by any language that supports the .NET Framework, including Visual Basic.

Definition of a Stream
The .NET Framework uses streams to support reading from and writing to files. You can think of a stream as a

one-dimensional set of contiguous data, which has a beginning and an end, and where the cursor indicates the current

position in the stream.

Stream Operations
The data contained in the stream may come from memory, a file, or a TCP/IP socket. Streams have fundamental

operations that can be applied to them:

Visual Studio 2015
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Reading. You can read from a stream, transferring data from the stream into a data structure, such as a string or an

array of bytes.

Writing. You can write to a stream, transferring data from a data source into the stream.

Seeking. You can query and modify your position in the stream.

For more information, see Composing Streams.

Types of Streams
In the .NET Framework, a stream is represented by the Stream class, which forms the abstract class for all other streams.

You cannot directly create an instance of the Stream class, but must use one of the classes it implements.

There are many types of streams, but for the purposes of working with file input/output (I/O), the most important types

are the FileStream class, which provides a way to read from and write to files, and the IsolatedStorageFileStream class,

which provides a way to create files and directories in isolated storage. Other streams that can be used when working with

file I/O include:

BufferedStream

CryptoStream

MemoryStream

NetworkStream.

The following table lists tasks commonly accomplished with a stream:

To See

Read and write to a data file How to: Read and Write to a Newly Created Data File

Read text from a file How to: Read Text from a File

Write text to a file How to: Write Text to a File

Read characters from a string How to: Read Characters from a String

Write characters to a string How to: Write Characters to a String

Encrypt data Encrypting Data

Decrypt data Decrypting Data
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File Access and Attributes
You can control how files are created, opened, and shared with the FileAccess, FileMode, and FileShare enumerations,

which contain the flags used by the constructors of the FileStream class. For example, when you open or create a new

FileStream, the FileMode enumeration allows you to specify whether the file is opened for appending, whether a new file

is created if the specified file does not exist, whether the file is overwritten, and so forth.

The FileAttributes enumeration enables the gathering of file-specific information. The FileAttributes enumeration returns

the file's stored attributes, such as whether it is compressed, encrypted, hidden, read-only, an archive, a directory, a

system file, or a temporary file.

The following table lists tasks involving file access and file attributes:

To See

Open and append text to a log file How to: Open and Append to a Log File

Determine the attributes of a file FileAttributes

File Permissions
Controlling access to files and directories can be done with the FileIOPermission class. This may be particularly important

for developers working with Web Forms, which by default run within the context of a special local user account named

ASPNET, which is created as part of the ASP.NET and .NET Framework installations. When such an application requests

access to a resource, the ASPNET user account has limited permissions, which may prevent the user from performing

actions such as writing to a file from a Web application. For more information, see Security Permissions, and the

FileIOPermission.

Isolated File Storage
Isolated storage is an attempt to solve problems created when working with files where the user or code may lack

necessary permissions. Isolated storage assigns each user a data compartment, which can hold one or more stores. Stores

can be isolated from each other by user and by assembly. Only the user and assembly that created a store have access to

it. A store acts as a complete virtual file system—within one store you can create and manipulate directories and files.

The following table lists tasks commonly associated with isolated file storage.

To See

Create an isolated store How to: Obtain Stores for Isolated Storage

Enumerate isolated stores How to: Enumerate Stores for Isolated Storage
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Delete an isolated store How to: Delete Stores in Isolated Storage

Create a file or directory in isolated storage How to: Create Files and Directories in Isolated Storage

Find a file in isolated storage How to: Find Existing Files and Directories in Isolated Storage

Read from or write to a file in insolated storage How to: Read and Write to Files in Isolated Storage

Delete a file or directory in isolated storage How to: Delete Files and Directories in Isolated Storage

File Events
The FileSystemWatcher component allows you to watch for changes in files and directories on your system or on any

computer to which you have network access. For example, if a file is modified, you might want to send a user an alert that

the change has taken place. When changes occur, one or more events are raised, stored in a buffer, and handed to the

FileSystemWatcher component for processing.

See Also
Composing Streams

File and Stream I/O

Asynchronous File I/O

Classes Used in .NET Framework File I/O and the File System (Visual Basic)
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Walkthrough: Manipulating Files by Using
.NET Framework Methods (Visual Basic)

 

This walkthrough demonstrates how to open and read a file using the StreamReader class, check to see if a file is being

accessed, search for a string within a file read with an instance of the StreamReader class, and write to a file using the

StreamWriter class.

Note

Your computer might show different names or locations for some of the Visual Studio user interface elements in the

following instructions. The Visual Studio edition that you have and the settings that you use determine these elements.

For more information, see Personalizing the Visual Studio IDE.

Creating the Application
Start Visual Studio and begin the project by creating a form that the user can use to write to the designated file.

To create the project

On the File menu, select New Project.1. 

In the New Project pane, click Windows Application.2. 

In the Name box type MyDiary and click OK.

Visual Studio adds the project to Solution Explorer, and the Windows Forms Designer opens.

3. 

Add the controls in the following table to the form and set the corresponding values for their properties.4. 

Object Properties Value

Button Name

Text

Submit

Submit Entry

Button Name

Text

Clear

Clear Entry

Visual Studio 2015
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TextBox Name

Text

Multiline

Entry

Please enter something.

False

Writing to the File
To add the ability to write to a file via the application, use the StreamWriter class. StreamWriter is designed for character

output in a particular encoding, whereas the Stream class is designed for byte input and output. Use StreamWriter for

writing lines of information to a standard text file. For more information on the StreamWriter class, see StreamWriter.

To add writing functionality

From the View menu, choose Code to open the Code Editor.1. 

Because the application references the System.IO namespace, add the following statements at the very beginning

of your code, before the class declaration for the form, which begins Public Class Form1.

Before writing to the file, you must create an instance of a StreamWriter class.

2. 

From the View menu, choose Designer to return to the Windows Forms Designer. Double-click the Submit

button to create a Click event handler for the button, and then add the following code.

3. 

Note

The Visual Studio Integrated Development Environment (IDE) will return to the Code Editor and position the insertion

point within the event handler where you should add the code.

To write to the file, use the Write method of the StreamWriter class. Add the following code directly after Dim fw

As StreamWriter. You do not need to worry that an exception will be thrown if the file is not found, because it

will be created if it does not already exist.

1. 

Imports System

Imports System.IO

Dim fw As StreamWriter

Dim ReadString As String

Try

VB

VB

VB
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Make sure that the user cannot submit a blank entry by adding the following code directly after Dim ReadString

As String.

2. 

Because this is a diary, the user will want to assign a date to each entry. Insert the following code after fw = New

StreamWriter("C:\MyDiary.txt", True) to set the variable Today to the current date.

3. 

Finally, attach code to clear the TextBox. Add the following code to the Clear button's Click event.4. 

Adding Display Features to the Diary
In this section, you add a feature that displays the latest entry in the DisplayEntry TextBox. You can also add a

ComboBox that displays various entries and from which a user can select an entry to display in the

DisplayEntry TextBox. An instance of the StreamReader class reads from MyDiary.txt. Like the StreamWriter class,

StreamReader is intended for use with text files.

For this section of the walkthrough, add the controls in the following table to the form and set the corresponding values

for their properties.

'Pass the file path and name to the StreamWriter constructor.

'Indicate that Append is True, so file will not be overwritten.

    fw = New StreamWriter("C:\MyDiary.txt", True)

    ReadString = Entry.Text

    fw.WriteLine(ReadString)

Finally

'Close the file.

    fw.Close()

End Try

If (Entry.Text = "" Or Entry.Text = "Please enter something.") Then

    Entry.Text = "Please enter something."

Return

End If

Dim Today As DateTime

Today = Now

fw.Write(CStr(Today))

fw.Write(ControlChars.CrLf)

Entry.Text = ""

VB

VB
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Control Properties Values

TextBox  Name

Visible

Size

Multiline

DisplayEntry

False

120,60

True

Button  Name

Text

Display

Display

Button Name

Text

GetEntries

Get Entries

ComboBox  Name

Text

Enabled

PickEntries

Select an Entry

False

To populate the combo box

The PickEntries ComboBox is used to display the dates on which a user submits each entry, so the user can

select an entry from a specific date. Create a Click event handler to the GetEntries button and add the following

code.

1. 

Dim fr As StreamReader = Nothing

Dim FileString As String

FileString = ""

Try

    fr = New System.IO.StreamReader("C:\MyDiary.txt")

    PickEntries.Items.Clear()

    PickEntries.Enabled = True

Do

        FileString = fr.ReadLine

If IsDate(FileString) Then

            PickEntries.Items.Add(FileString)

End If

Loop Until (FileString Is Nothing)

Finally

If fr IsNot Nothing Then

        fr.Close()

End If

End Try

PickEntries.Enabled = True

VB

Walkthrough: Manipulating Files by Using .NET Framework Methods (Vi... https://msdn.microsoft.com/en-us/library/1xac6e1y(d=printer)

4 of 8 03.09.2016 23:48



To test your code, press F5 to compile the application, and then click Get Entries. Click the drop-down arrow in

the ComboBox to display the entry dates.

2. 

To choose and display individual entries

Create a Click event handler for the Display button and add the following code.1. 

To test your code, press F5 to compile the application, and then submit an entry. Click Get Entries, select an entry

from the ComboBox, and then click Display. The contents of the selected entry appear in the

DisplayEntry TextBox.

2. 

Enabling Users to Delete or Modify Entries
Finally, you can include additional functionality enables users to delete or modify an entry by using DeleteEntry and

Dim fr As StreamReader

Dim ReadString As String

'Make sure ReadString begins empty.

ReadString = ""

Dim FileString As String

fr = New StreamReader("C:\MyDiary.txt")

'If no entry has been selected, show the whole file.

If PickEntries.Enabled = False Or PickEntries.SelectedText Is Nothing Then

Do

'Read a line from the file into FileString.

        FileString = fr.ReadLine

'add it to ReadString

        ReadString = ReadString & ControlChars.CrLf & FileString

Loop Until (FileString = Nothing)

Else

'An entry has been selected, find the line that matches.

Do

        FileString = fr.ReadLine

Loop Until FileString = CStr(PickEntries.SelectedItem)

    FileString = CStr(PickEntries.SelectedItem) & ControlChars.CrLf

    ReadString = FileString & fr.ReadLine

'Read from the file until EOF or another Date is found.

Do Until ((fr.Peek < 0) Or (IsDate(fr.ReadLine)))

        ReadString = ReadString & fr.ReadLine

Loop

End If

fr.Close()

DisplayEntry.Visible = True

DisplayEntry.Text = ReadString

VB
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EditEntry buttons. Both buttons remain disabled unless an entry is displayed.

Add the controls in the following table to the form and set the corresponding values for their properties.

Control Properties Values

Button  Name

Text

Enabled

DeleteEntry

Delete Entry

False

Button  Name

Text

Enabled

EditEntry

Edit Entry

False

Button Name

Text

Enabled

SubmitEdit

Submit Edit

False

To enable deletion and modification of entries

Add the following code to the Display button's Click event, after DisplayEntry.Text = ReadString.1. 

Create a Click event handler for the DeleteEntry button and add the following code.2. 

DeleteEntry.enabled = True

Dim fr As StreamReader

Dim ReadString As String

Dim WriteString As String

Dim ConfirmDelete As MsgBoxResult

fr = New StreamReader("C:\MyDiary.txt")

ReadString = fr.ReadLine

' Read through the textfile

Do Until (fr.Peek < 0)

    ReadString = ReadString & vbCrLf & fr.ReadLine

Loop

WriteString = Replace(ReadString, DisplayEntry.Text, "")

fr.Close()

' Check to make sure the user wishes to delete the entry

ConfirmDelete = MsgBox("Do you really wish to delete this entry?",

VB
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When a user displays an entry, the EditEntry button becomes enabled. Add the following code to the Click event

of the Display button after DisplayEntry.Text = ReadString.

3. 

Create a Click event handler for the EditEntry button and add the following code.4. 

Create a Click event handler for the SubmitEdit button and add the following code5. 

  MsgBoxStyle.OKCancel)

If ConfirmDelete = MsgBoxResult.OK Then

    File.Delete("C:\MyDiary.txt")

Dim fw As StreamWriter = File.CreateText("C:\MyDiary.txt")

    fw.WriteLine(WriteString)

    fw.Close()

' Reset controls on the form

    DisplayEntry.Text = ""

    PickEntries.Text = ""

    PickEntries.Items.Clear()

    PickEntries.Enabled = False

    DeleteEntry.Enabled = False

End If

EditEntry.Enabled = True

Entry.Text = DisplayEntry.Text

SubmitEdit.Enabled = True

Dim fr As StreamReader

Dim ReadString As String

Dim WriteString As String

If Entry.Text = "" Then

    MsgBox("Use Delete to Delete an Entry")

Return

End If

fr = New StreamReader("C:\MyDiary.txt")

ReadString = fr.ReadLine

Do Until (fr.Peek < 0)

    ReadString = ReadString & vbCrLf & fr.ReadLine

Loop

WriteString = Replace(ReadString, DisplayEntry.Text, Entry.Text)

fr.Close()

File.Delete("C:\MyDiary.txt")

Dim fw As StreamWriter = File.CreateText("C:\MyDiary.txt")

fw.WriteLine(WriteString)

fw.Close()

DisplayEntry.Text = Entry.Text

VB
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VB
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To test your code, press F5 to compile the application. Click Get Entries, select an entry, and then click Display. The entry

appears in the DisplayEntry TextBox. Click Edit Entry. The entry appears in the Entry TextBox. Edit the entry in the

Entry TextBox and click Submit Edit. Open the MyDiary.txt file to confirm your correction. Now select an entry and

click Delete Entry. When the MessageBox requests confirmation, click OK. Close the application and open MyDiary.txt

to confirm the deletion.

See Also
StreamReader

StreamWriter

Visual Basic Language Walkthroughs
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Entry.Text = ""

EditEntry.Enabled = False

SubmitEdit.Enabled = False

Walkthrough: Manipulating Files by Using .NET Framework Methods (Vi... https://msdn.microsoft.com/en-us/library/1xac6e1y(d=printer)

8 of 8 03.09.2016 23:48



Walkthrough: Test-First Support with the
Generate From Usage Feature

 

This topic demonstrates how to use the Generate From Usage feature, which supports test-first development.

Test-first development is an approach to software design in which you first write unit tests based on product specifications,

and then write the source code that is required to make the tests succeed. Visual Studio supports test-first development by

generating new types and members in the source code when you first reference them in your test cases, before they are

defined.

Visual Studio generates the new types and members with minimal interruption to your workflow. You can create stubs for

types, methods, properties, fields, or constructors without leaving your current location in code. When you open a dialog

box to specify options for type generation, the focus returns immediately to the current open file when the dialog box

closes.

The Generate From Usage feature can be used with test frameworks that integrate with Visual Studio. In this topic, the

Microsoft Unit Testing Framework is demonstrated.

Note

Your computer might show different names or locations for some of the Visual Studio user interface elements in the

following instructions. The Visual Studio edition that you have and the settings that you use determine these elements.

For more information, see Personalizing the Visual Studio IDE.

To create a Windows Class Library project and a Test project

In Visual C# or Visual Basic, create a new Windows Class Library project. Name it GFUDemo_VB or GFUDemo_CS,

depending on which language you are using.

1. 

In Solution Explorer, right-click the solution icon at the top, point to Add, and then click New Project. In the New

Project dialog box, in the Project Types pane on the left, click Test.

2. 

In the Templates pane, click Unit Test Project and accept the default name of UnitTestProject1. The following

illustration shows the dialog box when it appears in Visual C#. In Visual Basic, the dialog box looks similar.

3. 

Visual Studio 2015
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New Project dialog box

Click OK to close the New Project dialog box. You are now ready to begin writing tests4. 

To generate a new class from a unit test

The test project contains a file that is named UnitTest1. Double-click this file in Solution Explorer to open it in the

Code Editor. A test class and test method have been generated.

1. 

Locate the declaration for class UnitTest1 and rename it to AutomobileTest. In C#, if a UnitTest1() constructor is

present, rename it to AutomobileTest().

Note

IntelliSense now provides two alternatives for IntelliSense statement completion: completion mode and suggestion

mode. Use suggestion mode for situations in which classes and members are used before they are defined. When

an IntelliSense window is open, you can press CTRL+ALT+SPACEBAR to toggle between completion mode and

suggestion mode. See Using IntelliSense for more information. Suggestion mode will help when you are typing

Automobile in the next step.

2. 

Locate the TestMethod1() method and rename it to DefaultAutomobileIsInitializedCorrectly(). Inside this

method, create a new instance of a class named Automobile, as shown in the following illustrations. A wavy underline

appears, which indicates a compile-time error, and a smart tag appears under the type name. The exact location of

the smart tag varies, depending on whether you are using Visual Basic or Visual C#.

3. 
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Visual Basic

Visual C#

Rest the mouse pointer over the smart tag to see an error message that states that no type named Automobile is

defined yet. Click the smart tag or press CTRL+. (CTRL+period) to open the Generate From Usage shortcut menu, as

shown in the following illustrations.

Visual Basic

Visual C#

4. 

Now you have two choices. You could click Generate 'Class Automobile' to create a new file in your test project

and populate it with an empty class named Automobile. This is a quick way to create a new class in a new file that has

default access modifiers in the current project. You can also click Generate new type to open the Generate New

Type dialog box. This provides options that include putting the class in an existing file and adding the file to another

project.

Click Generate new type to open the Generate New Type dialog box, which is shown in the following illustration.

In the Project list, click GFUDemo_VB or GFUDemo_CS to instruct Visual Studio to add the file to the source code

project instead of the test project.

5. 
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Generate New Type dialog box

Click OK to close the dialog box and create the new file.6. 

In Solution Explorer, look under the GFUDemo_VB or GFUDemo_CS project node to verify that the new

Automobile.vb or Automobile.cs file is there. In the Code Editor, the focus is still in

AutomobileTest.DefaultAutomobileIsInitializedCorrectly. You can continue to write your test with a

minimum of interruption.

7. 

To generate a property stub

Assume that the product specification states that the Automobile class has two public properties named Model and

TopSpeed. These properties must be initialized with default values of "Not specified" and ‐1 by the default

constructor. The following unit test will verify that the default constructor sets the properties to their correct default

values.

Add the following line of code to DefaultAutomobileIsInitializedCorrectly.

Because the code references two undefined properties on Automobile, a smart tag appears. Click the smart tag for

Model and then click Generate property stub. Generate a property stub for the TopSpeed property also.

In the Automobile class, the types of the new properties are correctly inferred from the context.

The following illustration shows the smart tag shortcut menu.

1. 

Assert.IsTrue((myAuto.Model = "Not specified") And (myAuto.TopSpeed = ‐1))

VB
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Visual Basic

Visual C#

To locate the source code

Use the Navigate To feature to navigate to the Automobile.cs or Automobile.vb source code file so that you can

verify that the new properties have been generated.

The Navigate To feature enables you to quickly enter a text string, such as a type name or part of a name, and go to

the desired location by clicking the element in the result list.

Open the Navigate To dialog box by clicking in the Code Editor and pressing CTRL+, (CTRL+comma). In the text

box, type automobile. Click the Automobile class in the list, and then click OK.

The Navigate To window is shown in the following illustration.

1. 
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Navigate To window

To generate a stub for a new constructor

In this test method, you will generate a constructor stub that will initialize the Model and TopSpeed properties to

have values that you specify. Later, you will add more code to complete the test. Add the following additional test

method to your AutomobileTest class.

1. 

Click the smart tag under the new class constructor and then click Generate constructor stub. In the Automobile

class file, notice that the new constructor has examined the names of the local variables that are used in the

constructor call, found properties that have the same names in the Automobile class, and supplied code in the

constructor body to store the argument values in the Model and TopSpeed properties. (In Visual Basic, the _model

and _topSpeed fields in the new constructor are the implicitly defined backing fields for the Model and TopSpeed

properties.)

2. 

After you generate the new constructor, a wavy underline appears under the call to the default constructor in

DefaultAutomobileIsInitializedCorrectly. The error message states that the Automobile class has no

constructor that takes zero arguments. To generate an explicit default constructor that does not have parameters,

click the smart tag and then click Generate constructor stub.

3. 

To generate a stub for a method

<TestMethod()> Public Sub AutomobileWithModelNameCanStart()

Dim model As String = "Contoso"

Dim topSpeed As Integer = 199

Dim myAuto As New Automobile(model, topSpeed)

End Sub

VB
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Assume that the specification states that a new Automobile can be put into a Running state if its Model and

TopSpeed properties are set to something other than the default values. Add the following lines to the

AutomobileWithModelNameCanStart method.

1. 

Click the smart tag for the myAuto.Start method call and then click Generate method stub.2. 

Click the smart tag for the IsRunning property and then click Generate property stub. The Automobile class now

contains the following code.

3. 

To run the tests

On the Unit Test menu, point to Run Unit Tests, and then click All Tests. This command runs all tests in all test

frameworks that are written for the current solution.

In this case, there are two tests, and they both fail, as expected. The DefaultAutomobileIsInitializedCorrectly

test fails because the Assert.IsTrue condition returns False. The AutomobileWithModelNameCanStart test fails

because the Start method in the Automobile class throws an exception.

The Test Results window is shown in the following illustration.

1. 

myAuto.Start()

Assert.IsTrue(myAuto.IsRunning = True)

Public Class Automobile

Sub New(ByVal model As String, ByVal topSpeed As Integer)

        _model = model

        _topSpeed = topSpeed

End Sub

Sub New()

' TODO: Complete member initialization 

End Sub

Property Model() As String

Property TopSpeed As Integer

Property IsRunning As Boolean

Sub Start()

Throw New NotImplementedException

End Sub

End Class

VB

VB
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Test Results window

In the Test Results window, double-click on each test result row to go to the location of each test failure.2. 

To implement the source code

Add the following code to the default constructor so that the Model, TopSpeed and IsRunning properties are all

initialized to their correct default values of "Not specified", ‐1, and True (true).

1. 

When the Start method is called, it should set the IsRunning flag to true only if the Model or TopSpeed properties

are set to something other than their default value. Remove the NotImplementedException from the method body

and add the following code.

2. 

Sub New()

    Model = "Not specified"

    TopSpeed = ‐1

    IsRunning = True

End Sub

Sub Start()

If Model <> "Not specified" Or TopSpeed <> ‐1 Then

        IsRunning = True

Else

        IsRunning = False

End If

End Sub

VB

VB
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To run the tests again

On the Test menu, point to Run, and then click All Tests in Solution. This time the tests pass. The Test Results

window is shown in the following illustration.

Test Results window

1. 

See Also
Generate From Usage

Writing Code in the Code and Text Editor

Using IntelliSense

Unit Test Your Code
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